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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level
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■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs, DVDs, or manuals
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Support agreement resources
If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America
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Introduction to NetBackup
for DB2

This chapter includes the following topics:

■ Features of NetBackup for DB2

■ NetBackup for DB2 overview

Features of NetBackup for DB2
Table 1-1 shows NetBackup for DB2’s main features and introduces some terms
used in this documentation.

Table 1-1 NetBackup for DB2 features and descriptions

DescriptionFeature

All devices supported by Media Manager are available to
NetBackup for DB2.

Media and device
management

NetBackup scheduling facilities on the master server can be used
to schedule automatic and unattended DB2 backups.

This feature also lets you choose the times when these operations
can occur. For example, to prevent interference with normal
daytime operations, you can schedule your database backups to
occur only at night.

Scheduling facilities

NetBackup for DB2 lets you take advantage of NetBackup’s
multiplexing capabilities. Multiplexing directs multiple data
streams to one backup device, thereby reducing the time necessary
to complete the operation.

Multiplexed backups
and restores
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Table 1-1 NetBackup for DB2 features and descriptions (continued)

DescriptionFeature

All backups and restores run simultaneously and transparently
without any action from the NetBackup administrator.

The database administrator can run database backup and restore
operations through NetBackup. An administrator or any other
authorized user can use NetBackup to run database backups and
restores.

Transparent DB2 and
regular file system
backup and restore
operations

It is possible to share the same devices and media used for other
backups or to give DB2 exclusive use of certain devices and media.
NetBackup for DB2 can use Media Manager, disk, and PureDisk
storage units.

Sharing the same
storage units used for
other file backups

From the NetBackup master server, you can schedule database
backups or start them manually for any client. The DB2 databases
can also reside on hosts that are different from the devices on
which NetBackup stores the backups.

Centralized and
networked backup
operations

NetBackup provides the following graphical user interfaces for
client users and administrators:

■ Backup, Archive, and Restore user interface

■ NetBackup Administration Console for Java

■ NetBackup Administration Console for Windows

A database administrator or NetBackup administrator can start
backup or restore operations for DB2 from the NetBackup
graphical user interface on the master server.

A database administrator can also use the IBM DB2 control center
or command line processor to start user-directed backup and
restore operations.

Graphical user
interfaces

The NetBackup for DB2 database wizards can create backup and
recovery templates. You can launch the backup wizard and the
recovery wizard from the Backup, Archive, and Restore interface.
The wizards generate platform-independent templates that
contain configuration information that the software uses when
performing backups and restores. Because the wizard-generated
templates do not support all the features native to DB2, you may
want to write a customized backup or restore script in an
operating-system defined scripting language. You can use a
template as the base for a script.

Templates

Introduction to NetBackup for DB2
Features of NetBackup for DB2
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Table 1-1 NetBackup for DB2 features and descriptions (continued)

DescriptionFeature

NetBackup for DB2 supports the parallel backup and restore
capabilities of DB2 commands. For example, this permits the user
to run more than one tape device at a time for a single DB2 backup
or restore, thereby reducing the time necessary to complete the
operation.

Parallel backup and
restore operations

Compression increases backup performance over the network and
reduces the size of the backup image that NetBackup writes to the
storage unit.

Compression

For more information on general NetBackup terminology, see the NetBackup
Administrator’s Guide, Volume I.

NetBackup for DB2 overview
NetBackup for DB2 integrates the database backup and recovery capabilities of
DB2 with the backup and recovery management capabilities of NetBackup.

The server that hosts the DB2 database must be a NetBackup client.

On Windows, NetBackup for DB2 must be licensed on the server.

On UNIX and Linux, NetBackup for DB2 must be installed on the server.

Figure 1-1 shows the hardware components and software components for a
NetBackup for DB2 environment.
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Figure 1-1 NetBackup for DB2 components

NetBackup master server
or remote media server

DB2 database software supplies:

– Commands:

BACKUP DATABASE,

RESTORE DATABASE

System hosting the DB2 database

Network (TCP/IP)

NetBackup for DB2 supplies:

– NBDB2 Vendor I/O Library

– GUI for browsing databases and creating backup and
restore templates

– Sample configuration file (db2.conf)

– Sample script files

NetBackup software:

– NetBackup master server

– NetBackup media server

Additional required NetBackup software:

– NetBackup Client

Storage unit

DB2 database

RECOVER DATABASE (DB2 8.2 and later)

(if the system is a media server)

– UNIX and Linux: User exit program (db2uext2.64)

About the NetBackup for DB2 components
Table 1-2 describes the main NetBackup components in a NetBackup for DB2
environment.

Introduction to NetBackup for DB2
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Table 1-2 NetBackup for DB2 component descriptions

DescriptionComponent

The DB2BACKUP andRESTORE commands use the NBDB2 vendor
I/O library to send data buffers between a DB2 database and
NetBackup.

You specify the library as the argument to the LOAD parameter of
the DB2 BACKUP and RESTORE commands.

The installation program installs the vendor library in the
following location:

On Windows: install_path\NetBackup\bin\nbdb2.dll

On UNIX and Linux: /usr/openv/netbackup/bin

On UNIX and Linux, the name of the vendor library differs,
depending on your platform as follows:

■ 64-bit Solaris SPARC and 64-bit Linux x86: nbdb2.so64

■ 64-bit AIX and HP-UX PARISC: nbdb2.sl64

■ 64-bit Linux Itanium, HP Itanium, and IBM pSeries:nbdb2.so

NBDB2 vendor I/O
library

The NetBackup for DB2 user exit program, db2uext2, provides
one method for backing up and restoring the DB2 archive log files.

Use this method at the following times:

■ When you use the DB2 BACKUP command or ROLLFORWARD
command to back up or restore databases.

■ When the user exits the database with the DB2 TERMINATE or
DISCONNECT command.

■ When the log file fills and DB2 starts writing transactions to
another log file.

■ The DB2 ARCHIVE LOG command is issued.

The user exit program backs up and restores the archive logs as
files. The file is calleddb2uext2.64. NetBackup for DB2 supports
this method for protecting the archive logs on all supported DB2
releases.

The user exit program resides in the following location:

On Windows: %DB2_INSTANCE%\bin\db2uext2.exe

On UNIX and Linux:$DB2_INSTANCE/sqllib/adm/db2uext2.

Other methods are available for backing up archive log files.

See “About log archiving” on page 25.

User exit program
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Table 1-2 NetBackup for DB2 component descriptions (continued)

DescriptionComponent

The installation software installs the following sample files:

■ A sample configuration file (db2.conf file). The db2.conf
file includes specifications for backups and restores, and it
provides information on policies and schedules. The NetBackup
for DB2 library and user exit program use the information in
this file.

■ Sample backup and restore scripts. NetBackup can invoke a
script to perform a scheduled backup or restore of a DB2
database. The scripts contain DB2 BACKUP or RESTORE
commands for use with NetBackup.

Alternatively, users can use the NetBackup for DB2 wizards
to create backup and restore templates. You can use the
templates in place of scripts, and you can convert templates
into scripts.

The installation software writes these sample files to the following
location:

On Windows:install_path\NetBackup\dbext\db2\samples

On UNIX and Linux:
/usr/openv/netbackup/ext/db_ext/db2/scripts.

To use the sample files, copy the sample files to working
directories and modify them for your own use.

Sample configuration
file (db2.conf) and
script files

NetBackup for DB2 provides wizards that enable you to create
backup and recovery templates. You invoke the wizards by
browsing for and selecting a DB2 database object in the Backup,
Archive, and Restore interface. After you supply information about
the operation, the wizard creates a template that you can run
immediately or store on the server (for backup templates). You
can use the stored backup templates in scheduled backups through
a NetBackup policy. You can also use them to perform manual
backups on the NetBackup for DB2 client.

NetBackup for DB2
backup wizard and
recovery wizard

About NetBackup for DB2 terminology
DB2 supports archiving its log file through a user exit program or through a vendor
library. DB2 supports backing up the archive log files by using a vendor library
in its 8.2 and later releases. NetBackup for DB2 supplies a user exit program and
a library to support both of these methods.

Introduction to NetBackup for DB2
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The DB2 syntax for specifying these archive log methods differs from release to
release. NetBackup for DB2 topics use the terms "user exit" and "VENDOR" to
differentiate the methods.

Table 1-3 shows the DB2 syntax you can use to specify these methods within DB2.
It indicates the term that the DB2 for NetBackup uses to describe each method.

Table 1-3 Use of user exit and VENDOR terminology

Setting used with "VENDOR"Settings used with "user exit"

LOGARCHMETH1=VENDORlibraryLOGARCHMETH1=LOGRETAIN
LOGARCHMETH1=USEREXIT
USEREXIT=ON
USEREXIT=YES
LOGRETAIN=ON
LOGRETAIN=RECOVERY

When VENDOR is used, archive logs are backed up by means of the NetBackup for
DB2 vendor library. The full specification for this archive log method is as follows:

On Windows: LOGARCHMETH1=VENDOR:install_path\NetBackup\bin\nbdb2.dll

On UNIX and Linux:LOGARCHMETH1=VENDOR:/usr/openv/netbackup/bin/library

For library, specify an operating system specific library.

When a user exit program is used, archive logs are backed up by means of the
NetBackup for DB2 user exit program. The DB2 syntax that defines the user exit
program includes the USEREXIT and LOGRETAIN keywords that are specified in a
configuration parameter.
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Installing NetBackup for
DB2

This chapter includes the following topics:

■ Planning the installation of NetBackup for DB2

■ Verifying the operating system and platform compatibility for NetBackup for
DB2

■ Adding license keys for NetBackup for DB2 backups

■ About log archiving

■ Specifying the DB2 home path (UNIX and Linux)

■ About adding new DB2 instances

Planning the installation of NetBackup for DB2
Table 2-1 shows the major installation steps needed to run NetBackup for DB2.
Each step contains one or more links to pertinent procedures and concepts.

2Chapter



Table 2-1 Installation steps for NetBackup for DB2

DescriptionActionStep

See “Verifying the operating system and platform
compatibility for NetBackup for DB2” on page 22.

See “NetBackup server and client requirements for
NetBackup for DB2” on page 23.

See “DB2 server software requirements for NetBackup for
DB2” on page 23.

See “Requirements for installing NetBackup for DB2 in a
NetBackup cluster” on page 24.

Verify the installation prerequisites.Step 1

See “Adding license keys for NetBackup for DB2 backups”
on page 24.

Add the license key for NetBackup for
DB2.

Step 2

See “About log archiving” on page 25.Specify a log archive method.Step 3

See “Specifying the DB2 home path (UNIX and Linux)”
on page 27.

(UNIX and Linux) specify the DB2 home
path.

Step 4

See “About adding new DB2 instances” on page 28.Add a new database instance.Step 5

Verifying the operating system and platform
compatibility for NetBackup for DB2

Verify that the NetBackup for DB2 agent is supported on your operating system
or platform.

To verify operating system and compatibility

1 Go to the Symantec Support Web page:

http://www.symantec.com/business/support/index.jsp

2 Click on the link for NetBackup Enterprise Server.

3 In the list of documents, click on the following document:

NetBackup Database Agent Compatibility List

4 For information on supported cluster environments for NetBackup for DB2,
see the following document:

NetBackup Cluster Compatibility List

5 For information on support for Snapshot Client, see the following document:

NetBackup Snapshot Client Compatibility List

Installing NetBackup for DB2
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NetBackup server and client requirements for NetBackup for DB2

Note: To use NetBackup for DB2 with Snapshot Client, you must have a license
for NetBackup Snapshot Client.

Verify that the following requirements are met for the NetBackup server:

■ The NetBackup server software is installed and operational on the NetBackup
server. The NetBackup server platform can be any that NetBackup supports.
See the NetBackup Installation Guide.

■ Make sure that you configure any backup media that the storage unit uses.

The number of media volumes that are required depends on several things:

■ The devices used

■ The sizes of the databases that you want to back up

■ The amount of data that you want to archive

■ The size of your backups

■ The frequency of backups or archives

See the NetBackup Administrator’s Guide, Volume I.

Verify that the following requirements are met for the NetBackup clients:

■ The NetBackup client software is installed on the computer that has the
databases you want to back up.

DB2 server software requirements for NetBackup for DB2
Verify the following regarding the DB2 server software on the NetBackup server
or client:

■ DB2 server software must be installed and operational.

■ One or more DB2 instances must exist.

Note: In a DB2 EEE environment, install the NetBackup client software on
every node and client that DB2 uses.
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Requirements for installing NetBackup for DB2 in a NetBackup cluster
If you plan to use the database agent software on a NetBackup server configured
in a NetBackup cluster, verify the following requirements:

■ Your cluster environment is supported by NetBackup:
See “Verifying the operating system and platform compatibility for NetBackup
for DB2” on page 22.

■ The NetBackup server software is installed and configured to work in a
NetBackup cluster.
See the NetBackup Installation Guide.
See the NetBackup Clustered Master Server Administrator's Guide .

■ The DB2 server software is installed and operational on each node to which
NetBackup can failover.

■ On each node where NetBackup server resides, add the license key for the
database agent.

Adding license keys for NetBackup for DB2 backups

Note: To use NetBackup for DB2 with Snapshot Client, you must have a license
for NetBackup Snapshot Client.

To use NetBackup for DB2, add a valid license key for it on the master server.
More information is available on how to add license keys.

See the NetBackup Administrator’s Guide, Volume I.

In a NetBackup cluster, add the key on each node where the NetBackup server is
installed.

To add a NetBackup for DB2 license key in the NetBackup Administration Console

1 On the master server, open the NetBackup Administration Console.

2 Choose Help > License Keys.

3 Click the New icon.

4 Type the license key and click Add.

On UNIX and Linux, you can also add a license key by using the get_license_key
command.

Installing NetBackup for DB2
Adding license keys for NetBackup for DB2 backups
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To add a NetBackup for DB2 license key with the get_license_key command

1 From the master server server, run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

2 When the system prompts you, type the host name of the NetBackup master
server.

About log archiving
DB2 can write database archive logs by using several different methods. For a
roll-forward recovery, you need both the database itself and the archive logs from
the backup media. The DB2 parameters that specify an archive log method include
the LOGRETAIN, USEREXIT, and LOGARCHMETH1 keywords.

The following topics describe the archive methods and how to specify an archive
method in DB2.

See “Using the VENDOR archive method” on page 25.

See “Using the user exit archive method” on page 26.

The terms “VENDOR” and “user exit” describe the methods that DB2 supports
for log archiving. Ensure that you understand how the terms are used in this
manual.

See “About NetBackup for DB2 terminology” on page 18.

Using the VENDOR archive method
Only the DB2 8.2 release lets you use the VENDOR log archive method.

If you use this method, note the following:

■ The archive logs are backed up as part of the database, so you do not need a
separate NetBackup policy for them.

■ NetBackup for DB2 backs up and restores the archive log files as a byte stream.
This method uses the DB2 backup API and the DB2 restore API.
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To use the VENDOR archive method

1 Quiesce the DB2 database.

Perform this procedure and the configuration procedures at a time when
minimal changes are made to the DB2 database.

2 Specify the archive method. The syntax is as follows:

On Windows:
LOGARCHMETH1=VENDOR:install_path\NetBackup\bin\nbdb2.dll

On UNIX and Linux:
LOGARCHMETH1=VENDOR:/usr/openv/netbackup/bin/library

For the library name, refer to the following topic.

See “About the NetBackup for DB2 components” on page 16.

3 Verify your DB2 configuration to ensure that the appropriate log archiving
method for your site is enabled.

If necessary, edit your DB2 configuration specifications to specify the log
archiving method.

Using the user exit archive method
NetBackup for DB2 includes a user exit program that you can use to back up the
archive logs. Any DB2 release lets you use this log archive method. The syntax
for specifying the user exit method depends on the DB2 release.

If your DB2 configuration uses the USEREXIT or LOGRETAIN keywords in its
configuration parameters, note the following:

■ NetBackup for DB2 backs up and restores the archive log files as individual
files.

■ DB2 supports this archive method only for backward compatibility.

To use the user exit archive method

1 Quiesce the DB2 database.

Perform this procedure and the configuration procedures at a time when
minimal changes are made to the DB2 database.

2 Specify the archive method.

The method you use to specify these parameters and the syntax for these
parameters depends on the DB2 version level. For more information on the
effects of these parameters within DB2, or on the specific syntax for these
parameters, see your DB2 documentation.

Installing NetBackup for DB2
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3 If your DB2 configuration uses the USEREXIT or LOGRETAIN keywords in its
configuration parameters, configure one of the following:

■ On Windows, a separate NetBackup MS-Windows policy that includes the
archive logs.

■ On UNIX and Linux, a separate NetBackup Standard policy that includes
the archive logs.

■ On UNIX and Linux, directories for the user exit program to use when it
copies the archive logs. You may also want to create a separate NetBackup
Standard policy for backing up these directories.

■ On Windows, directories for the user exit program to use when it copies
the archive logs. You may also want to create a separate NetBackup
MS-Windows policy for backing up these directories.

■ On UNIX and Linux, modify an existing NetBackup Standard policy with
a user backup schedule. Include the archive log directories..

■ On Windows, modify an existing NetBackup MS-Windows policy with a
user backup schedule. Include the archive log directories.

4 Verify your DB2 configuration to ensure that the appropriate log archiving
method for your site is enabled.

If necessary, edit your DB2 configuration specifications to specify the log
archiving method.

Specifying the DB2 home path (UNIX and Linux)
After you add the license key for NetBackup for DB2, run this script on the
computer where the DB2 vendor software is installed. With this script, NetBackup
can gather additional information about your DB2 environment.

Complete this procedure at the following times:

■ After you specify a log archiving method in DB2.

■ If you licensed NetBackup for DB2 for the first time.

■ When you create a new DB2 instance.

To specify the DB2 home path

1 Change to the following directory:

/usr/openv/netbackup/bin

2 Run the following script:

./db2_config
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3 Supply the home path for the database instance.

For example:

/home/db2inst1

4 Add any other database instances, or enter n if you are finished.

About adding new DB2 instances
Adding new DB2 instances on a Windows system is different than adding new
instances on a UNIX or Linux system.

■ On Windows, the NetBackup for DB2 installation software writes the user exit
program to the following location:

install_path\NetBackup\dbext\DB2\db2uext2.exe

DB2 expects the db2uext2 executable to reside in the DB2 installation location.

If you reinstall or move the DB2 installation, manually copy db2uext2.exe

from the NetBackup location into the DB2 location.

■ On UNIX or Linux, if you install a new DB2 instance after you install NetBackup,
you need to add this new instance to the NetBackup configuration. This action
ensures that all new DB2 instances are included in backup operations.
See “Specifying the DB2 home path (UNIX and Linux)” on page 27.
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Configuring NetBackup for
DB2

This chapter includes the following topics:

■ Overview of NetBackup for DB2 configuration

■ About permissions for NetBackup for DB2 log files (UNIX and Linux)

■ About configuring a backup policy for a DB2 database

■ About adding backup selections to a DB2 policy

■ About adding schedules to a NetBackup for DB2 policy

■ Testing configuration settings for NetBackup for DB2

■ About backing up archive log files with the user exit program

■ Configuring the runtime environment

■ About NetBackup for DB2 templates and shell scripts

Overview of NetBackup for DB2 configuration
Before you configure NetBackup for DB2, complete the installation procedure.

You perform many configuration steps from the NetBackup Administration
Console on the master server. The type of console available depends on your
master server platform. NetBackup supports a Java interface for both Windows
and UNIX master servers. In addition, NetBackup supports a Windows interface
for Windows master servers.
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The Java and Windows interfaces are nearly identical. If interface differences
exist in the configuration procedures, the term “Windows” or “Java” appears in
the procedure to differentiate between the two interfaces.

Table 3-1 shows the three major parts of NetBackup for DB2 configuration.

Table 3-1 Major configuration tasks

DescriptionTask

A backup policy for a database defines the backup
criteria for a specific group of one or more clients.
To back up the database environment, you must
define at least one DB2 policy with the appropriate
schedules.

See “About configuring a backup policy for a DB2
database” on page 31.

Configure a backup policy for a DB2
database

To configure your runtime environment, you must
create a db2.conf file. This task includes a
description of the environment variables that
NetBackup creates.

See “Configuring the runtime environment”
on page 48.

Configure the runtime environment

To perform a scheduled NetBackup for DB2
backup, you must create a template or a shell
script. The template or the shell script controls
the backup job on the NetBackup for DB2 client.

See “About NetBackup for DB2 templates and
shell scripts” on page 61.

Create a template or shell script

About permissions for NetBackup for DB2 log files
(UNIX and Linux)

NetBackup uses the /usr/openv/netbackup/logs directory tree not only for the
recording of troubleshooting information, but for progress and communication
updates to users and other NetBackup applications. Restrictive permissions on
these directories can not only disable the collection of troubleshooting data, but
also prevent the application itself from functioning correctly.

Backup and restore operations fail when permissions are too restrictive. We
recommend that you make all of the usr/openv/netbackup/logs directories and
subdirectories readable and writeable by all users (777 permissions). However,
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security requirements may prohibit global read-write access. If so, you can restrict
permissions of specific directories to a single group or user if the following is true:
Processes that run as members of that group or as that user initiate all backup
and restore operations that are related to that directory.

Check that the /usr/openv/netbackup/logs/user_ops directory tree has 777
permissions. The items in this directory need to be accessible for the applications
to operate correctly.

If you restrict permissions on the other directories that are located in
/usr/openv/netbackup/logs, backup and restore operations are not affected.
However, troubleshooting efforts may be hindered when processes do not have
the appropriate permissions to update the debug logs therein.

About configuring a backup policy for a DB2database
A backup policy for a database defines the backup criteria for a specific group of
one or more clients.

These criteria include the following:

■ Storage unit and media to use

■ Policy attributes

■ Backup schedules

■ Clients to be backed up

■ Backup templates or script files to be run on the clients

To back up the database environment, define at least one DB2 policy with the
appropriate schedules. A configuration can have a single policy that includes all
clients, or there can be many policies, some of which include only one client.

Most requirements for database policies are the same as for file system backups.
In addition to the policy attributes for this database agent, other attributes are
available that you should consider.

See the NetBackup Administrator’s Guide, Volume I.

To add and configure a policy, see the following topics:

■ See “Adding a new NetBackup for DB2 policy” on page 32.

■ See “About policy attributes for NetBackup for DB2” on page 32.

■ See “About adding schedules to a NetBackup for DB2 policy” on page 39.

■ See “Adding clients to a NetBackup for DB2 policy” on page 33.

■ See “About adding backup selections to a DB2 policy” on page 35.
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Adding a new NetBackup for DB2 policy
This topic describes how to add a new backup policy for a database.

To add a new NetBackup for DB2 policy

1 Log on to the master server as administrator (Windows) or root (UNIX).

2 Start the NetBackup Administration Console.

3 If your site has more than one master server, choose the one on which you
want to add the policy.

4 Do one of the following:

■ Windows: In the left pane, right-click Policies and choose New Policy.

■ Java interface: In the left pane, click Policies. In the All Policies pane,
right-click the master server, and click New Policy.

5 In the Add a New Policy dialog box, in the Policy name box, type a unique
name for the new policy.

6 Click OK.

7 In the Add New Policy dialog box, in the Policy type list, select DB2.

The database agent policy type does not appear in the drop-down list unless
your master server has a license key for the database agent.

8 Complete the entries on the Attributes tab.

See “About policy attributes for NetBackup for DB2” on page 32.

9 Add other policy information as follows:

■ Add schedules.
See “About adding schedules to a NetBackup for DB2 policy” on page 39.

■ Add clients.
See “Adding clients to a NetBackup for DB2 policy” on page 33.

■ Add templates or scripts to the backup selections list.
See “About adding backup selections to a DB2 policy” on page 35.

10 When you have added all the schedules, clients, and backup selections you
need, click OK.

About policy attributes for NetBackup for DB2
With a few exceptions, NetBackup manages a database backup like a file system
backup. Other policy attributes vary according to your specific backup strategy
and system configuration.
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For more information on policy attributes, see the NetBackup Administrator’s
Guide, Volume I.

Table 3-2 Policy attribute descriptions for NetBackup for DB2 policies

DescriptionAttribute

Determines the types of clients that can be in the policy. In some cases the policy type
determines the types of backups that NetBackup can perform on those clients. To use the
DB2 database agent, you must define at least one policy of type that is DB2.

Policy type

For NetBackup for DB2, the Keyword phrase entry is ignored.Keyword phrase

This option enables backups with Snapshot Client.

See “NetBackup for DB2 with Snapshot Client features” on page 99.

Snapshot Client

Adding clients to a NetBackup for DB2 policy
The client list contains a list of the clients on which your scripts are run during
an automatic backup. A NetBackup client must be in at least one policy but can
be in more than one.

For a NetBackup for DB2 policy, clients you want to add must have the following
software installed:

■ DB2

■ NetBackup client or server

■ The backup or restore script(s), unless you use templates

To add clients to a NetBackup for DB2 policy

1 In the Policy dialog box, click the Clients tab.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

2 Click New.

3 Type the name of the client and press Enter (Windows) or click Add (Java).

If DB2 is installed in a NetBackup cluster, specify the virtual DB2 name as
the client name.

4 (Windows) To add another client, repeat step 2 and step 3.

5 (Java) To add another client, repeat step 3.

6 If this client is the last client you want to add, click OK.

7 (Java) In the Policy dialog box, click Close.
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Specifying the master server for a NetBackup for DB2 client
After you add your NetBackup for DB2 client to a policy, specify the master server
for the client in the NetBackup Administration Console.

Note: Add the server names to the master server before you configure the server
list on the client. To add server names on the client, see the following topic:

See “Specifying the NetBackup master server from the client” on page 61.

To specify the master server in the NetBackup Administration Console

1 In the left pane, expand NetBackupManagement>HostProperties>Clients.

2 Double-click the NetBackup for DB2 client name in the Clients list.

3 Click Servers.

4 Verify that the correct server displays in the Master Server box.

If the correct server does not display, click the server name in the Additional
Servers list, and click Make Master. Alternatively, click Add to add a new
server name to the list.

5 Click OK.

Configuring a policy to back up the configuration files
This topic shows how to create an automatic backup policy to back up the
NetBackup configuration files. If you want users to be able to back up configuration
files manually, you also must create a User Backup schedule.

To back up configuration files

1 Create an MS-Windows (Windows) or Standard (UNIX) policy.

2 Specify the attributes for the policy.

3 On the Schedules tab, create a full backup schedule.

4 In the Backup Selections list, add an entry that includes the full path name
of the directory that contains the configuration files.

5 Specify the clients to back up.

The clients must have the following installed:

■ DB2

■ NetBackup for DB2

If the client is installed in a NetBackup cluster, add the virtual host name to
the client list.
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Configuring the Maximum jobs per client
The following procedure shows how to set the Maximumjobsperclient attribute.

To configure the maximum jobs per client

1 In the left pane of the NetBackup Administration Console, expand NetBackup
Management > Host Properties.

2 Select Master Server.

3 In the right pane, double-click the server icon.

4 Click Global Attributes.

5 Change the Maximum jobs per client value to 99.

The Maximumjobsper client specifies the maximum number of concurrent
backups that are allowed per client. The default is 1.

You can use the following formula to calculate a smaller value for the Maximum
jobs per client setting:

Maximum jobs per client = number_of_sessions X number_of_policies

Refer to the following definitions:

The number of backup sessions between the backup server and
NetBackup on the client. Each separate session starts a new backup
job on the client.

number_of_sessions

The number of policies of any type that can back up this client at the
same time. This number can be greater than one. For example, a client
can be in two policies to back up two different databases. These backup
windows can overlap.

number_of_policies

Note: Enter a large enough value for the Maximum jobs per client attribute to
meet the number of jobs that DB2 runs. You may need to experiment with different
values at your site.

About adding backup selections to a DB2 policy
The backup selections list in a database policy has a different meaning than that
for non-database policies. For example, in a Standard or MS-Windows policy, the
list contains files and directories to be backed up.

In a database policy, you specify templates or scripts to be run.

Observe the following rules when you use templates or scripts:
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■ Make sure the scripts reside on each client in the client list.
Scripts can reside in any location. Make sure that NetBackup can access the
location you choose and that NetBackup can run the scripts.
Note that templates do not reside on the clients. Templates reside on the
NetBackup master server.

■ NetBackup installs sample scripts when you install the software; you can
modify these scripts for your own use.
Write the scripts to a location outside of the original installation location. In
this way future NetBackup installations do not overwrite your site’s scripts.

■ If you use NetBackup for DB2 in a NetBackup server cluster, make sure that
the scripts reside in a location that is available after a failover.

Add templates or scripts to the backup selections list only if you want to set up a
policy for automatic backups. These templates or scripts are run for manual
backups and for automatic schedules as specified under the Schedules tab.
NetBackup runs the templates or scripts in the order that the templates or scripts
appear in the backup selections list.

About backup schedules, templates, and scripts
Be aware of what may happen if an automatic schedule invokes a script that a
user authored. NetBackup does not provide safeguards to prevent an automatic
backup schedule, for example, from running a restore or recovery script.

To help guard against such mistakes, use a template instead of a script whenever
possible. When a template runs, it detects the backup type on the schedule. You
are responsible for specifying a template with the correct operation type (backup
or restore) in the policy.

Adding a template to the backup selections list from the Java interface
The following procedure describes how to add a templates to the backup selections
list with the Java interface.

Note: Be sure to specify the correct template name in the backup selections list
to prevent an error or a wrong operation.
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To add a template to the backup selections list from the Java interface

1 Open the Policy dialog box.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

2 Click the Backup Selections tab.

3 Click New.

4 From the Script or Template list, select a template or type the name of a
template.

Include the .tpl extension. Do not include the full path. For example,
weekly_full_backup.tpl.

5 Click Add to add the template to the list.

6 Click OK.

Adding a script to the backup selections list from the Java interface

Note: Be sure to specify the correct script name in the backup selections list to
prevent an error or a wrong operation.

To add a script to the backup selections list from the Java interface

1 Open the Policy dialog box.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

2 Click the Backup Selections tab.

3 Click New.

4 In the Script or Template box, type the full path name of a script on the client.

For example:

/backup_scripts/db/cold_backup.sh

C:\backup_scripts\db\cold_backup.cmd

5 Click Add to add the script to the list.

6 Click OK.
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Adding a template to the backup selections list from the Windows
interface

Note: Be sure to specify the correct template name in the backup selections list
to prevent an error or a wrong operation.

To add a template to the backup selections list from the Windows interface

1 In the Policy dialog box, click the Backup Selections tab.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

2 Click New.

3 Click the Template button.

Alternatively, you can type the name of the template with the .tpl extension.
Do not include the full path. For example, weekly_full_backup.tpl.

4 From the Template list, choose the correct template.

5 Click OK.

6 Click OK.

Adding a script to the backup selections list from the Windows interface

Note: Be sure to specify the correct script name in the backup selections list to
prevent an error or a wrong operation. The script must reside on the client before
you try to add it to the backup selections list.

To add a script to the backup selections list from the Windows interface

1 In the Policy dialog box, click the Backup Selections tab.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

2 Click New.
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3 Click the Remote Folder button.

Alternatively, you can type the full path name of the script on the client. For
example:

/backup_scripts/db/cold_backup.sh

C:\backup_scripts\db\cold_backup.cmd

4 Navigate to and select the script file.

5 Click OK.

6 Click OK.

About adding schedules to aNetBackup forDB2policy
Each policy has its own set of schedules. These schedules initiate automatic
backups and specify when a user can initiate operations. A database backup has
these types of schedules: application backup and automatic backup.

Configuring a NetBackup for DB2 application backup schedule
A database backup requires an application backup schedule. You cannot perform
backups if this type of schedule is not included in the policy. The NetBackup for
DB2 agent automatically creates this schedule and names it
Default-Application-Backup.

The backup window for an application backup schedule must encompass the time
period during which all scheduled jobs and unscheduled jobs can occur. This
window is necessary because the application backup schedule starts the processes
that are required for all database backups, including those started automatically.
You can choose to set the window for the application backup schedule for 24 hours
per day, seven days per week. This window ensures that your operations are never
locked out due to the application backup schedule.
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To configure an application backup schedule

1 In the Policy dialog box, click the Schedules tab.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console .

2 Double-click the schedule that is named Default-Application-Backup.

3 Specify the other properties for the schedule.

See “About NetBackup for DB2 schedule properties” on page 41.

Example application backup schedule for NetBackup for DB2
Specify the application backup schedule name in the db2.conf file on the client.
The db2.conf file is located in the following directory path:

UNIX and Linux: $DB2_Instance_Home/db2.conf

Windows: install_path\NetBackup\dbext\db2\db2.conf

Assume the following:

■ Users perform database backup operations during business hours, 08:00 to
13:00.

■ The automatic backups that use this policy start between 18:00 and 22:00.

In this scenario, the application backup schedule must have a start time of 0800
and a duration of 14 hours.

Table 3-3 Example settings for a NetBackup for DB2 application backup
schedule

SettingSchedule option

2 weeksRetention

Sunday through Saturday

00:08:00 - 22:00:00

Backup window

Configuring NetBackup for DB2 automatic backup schedules
If you plan to have NetBackup perform automatic backups, or if you use Snapshot
Client features, you need one or more automatic backup schedules.

To configure an automatic backup schedule

1 On the Policy dialog box, click the Schedules tab.

2 Click New.
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3 Specify a unique name for the schedule.

4 Select the Type of backup.

See “About the NetBackup for DB2 backup types” on page 42.

5 Specify the other properties for the schedule.

See “About NetBackup for DB2 schedule properties” on page 41.

6 Click OK.

Example automatic backup schedule for NetBackup for DB2
Table 3-4 shows example settings for automatic backup schedules.

Table 3-4 Example settings for NetBackup for DB2 automatic backup schedules

SettingSchedule propertyType of backup

2 weeksRetention (proxy backup
only)

Automatic Full Backup

Every weekFrequency

Sunday, 18:00:00 - 22:00:00Backup window

1 weekRetention (proxy backup
only)

Automatic Differential
Incremental Backup,
Automatic Cumulative
Incremental Backup

Every dayFrequency

Sunday through Saturday

18:00:00 - 22:00:00

Backup window

About NetBackup for DB2 schedule properties
This topic describes the schedule properties that have a different meaning for
database backups than for file system backups. Other schedule properties vary
according to your specific backup strategy and system configuration. Additional
information about other schedule properties is available.

See the NetBackup Administrator’s Guide, Volume I.
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Table 3-5 Description of schedule properties

DescriptionProperty

Specifies the type of backup that this schedule controls. The selection list shows only the
backup types that apply to the policy you want to configure.

See “About the NetBackup for DB2 backup types” on page 42.

Type of backup

You can schedule a backup in one of the following ways:

■ Frequency
This setting is used only for scheduled backups. It is not used for user-directed backups.
Frequency specifies the period of time that can elapse until the next backup or archive
operation begins on this schedule. For example, assume that the frequency is seven
days and a successful backup occurs on Wednesday. The next full backup does not
occur until the following Wednesday. Typically, incremental backups have a shorter
frequency than full backups.

■ Calendar
This setting is used only for scheduled backups. It is not used for user-directed backups.
The Calendar option allows you to schedule backup operations that are based on specific
dates, recurring week days, or recurring days of the month.

Schedule type

The retention period for an application backup schedule refers to the length of time that
NetBackup keeps backup images (stream-based backups). The retention period for an
automatic schedule controls how long NetBackup keeps records of when scheduled backups
occurred (proxy backups). For example, if your database is backed up once every Sunday
morning, you should select a retention period of at least 2 weeks.

The retention period is affected by the type of schedule you select, as follows:

■ Frequency-based scheduling

Set a retention period that is longer than the frequency setting for the schedule. For
example, if the frequency setting is set to one week, set the retention period to be more
than one week. The NetBackup scheduler compares the latest record of the automatic
backup schedule to the frequency of that automatic backup schedule to determine
whether a backup is due. This means that if you set the retention period to expire the
record too early, the scheduled backup frequency is unpredictable. However, if you set
the retention period to be longer than necessary, the NetBackup catalog accumulates
unnecessary records.

■ Calendar-based scheduling

The retention period setting is not significant for calendar-based scheduling.

Retention

If you want to specify multiple copies of a backup for the policy, configure Multiplecopies
on the application backup schedule.

Multiple copies

About the NetBackup for DB2 backup types
Each database agent has a unique set of backup schedules.
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Table 3-6 shows the DB2 backup schedules you can specify.

Table 3-6 DB2 backup types

DescriptionBackup type

The Application Backup schedule enables user-controlled
NetBackup operations from the client. These operations include
those initiated from the client and those initiated by an automatic
schedule on the master server. NetBackup uses the Application
Backup schedule when the user starts a backup manually.
Configure at least one Application Backup schedule for each
database policy. The Default-Application-Backup schedule is
configured automatically as an Application Backup schedule.

Application Backup

An Automatic full backup contains a copy of all the data. A full
backup is not the same as a whole database backup. Full means
that the backup is not one of the incremental backup types.

To perform a stream-based Automatic full backup, also specify
an Automatic Full Backup schedule for scheduled NetBackup
operations.

Snapshot Client only supports this type of backup and the
Block-Level Incremental (BLI) Backup.

Automatic Full Backup

An Automatic Differential incremental backup is an incremental
backup that is not cumulative. The backup contains a copy of the
database data that has changed since the most recent backup, full
or otherwise. This type of backup corresponds to the
INCREMENTAL DELTA option of the DB2 BACKUP command.

This type of backup takes less space and time than a cumulative
incremental backup. The backup includes only the data that
changed since the last backup of any type.

This type of backup is supported only for stream-based backups
and for BLI backups.

Automatic Differential
incremental backup

An Automatic Cumulative incremental backup is an incremental
backup that is cumulative. The backup contains a copy of the
database data that changed since the most recent full backup.
This type of backup corresponds to the INCREMENTAL option of
the DB2 BACKUP command.

Automatic Cumulative Incremental backups are supported only
for stream-based backups and for BLI backups.

This backup takes less time and space than a full backup; it
contains only the data that changed since the last full backup.

Automatic Cumulative
incremental backup
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Note: For the types of backup schedules, the information in this topic pertains to
stream-based backups. If you use the Snapshot Client option, some of the
information in that table may differ.

More information about backup schedules and Snapshot Client features is available.

See “NetBackup for DB2 with Snapshot Client features” on page 99.

Testing configuration settings for NetBackup for DB2
After you configure the master server for NetBackup for DB2, test the configuration
settings. Perform a manual backup (or backups) with the automatic backup
schedules you created. A description of status codes and other troubleshooting
information is available.

See the NetBackup Status Codes Reference Guide.

See the NetBackup Troubleshooting Guide.

To test the configuration settings

1 Log onto the master server as administrator (Windows) or root (UNIX).

2 Start the NetBackup Administration Console.

3 In the left pane, click Policies.

4 Click the policy you want to test.

5 Select Actions > Manual Backup.

The Schedules pane contains the name of an automatic schedule (or schedules)
configured for the policy that you want to test. The Clients pane contains the
name of the client(s) listed in the policy that you want to test.

6 Follow the directions in the Manual Backup dialog box.

7 To check the status of the backup, click Activity Monitor in the NetBackup
Administration Console.

The Activity Monitor and the script output indicate the status of the backup
operation.

For more information, see the Troubleshooting chapter.
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About backing up archive log files with the user exit
program

You can configure the user exit program to back up the archive logs. The user exit
program is db2uext2 (UNIX and Linux) or db2uext2.exe (Windows).

The backup can be configured in one of the following ways:

■ Save archive log files directly with NetBackup.
To back up archive log files in this way, configure an MS-Windows or Standard
policy with a User Backup schedule.
See “Configuring a policy to back up the archive logs” on page 47.
Then specify the ARCFUNC SAVE keywords in the configuration file, db2.conf.

See “Creating a db2.conf file for use with the user exit program” on page 48.

■ Copy archive log files to another directory for later backup by NetBackup.
To back up archive log files in this way, configure an MS-Windows or Standard
policy with a User Archive schedule (this schedule is optional)
See “Configuring a policy to back up the archive logs” on page 47.
Specify the ARCFUNC COPY keywords in the db2.conf file.

See “Creating a db2.conf file for use with the user exit program” on page 48.
You can coordinate the copy of the log files to a directory with a user archive.
In this case, the user exit program copies the file to an archive directory. To
free disk space, later you can perform a user archive to archive all the files in
the ARCDIR directory.

Do not specify ARCFUNC SAVE or ARCFUNC COPY if the VENDOR DB2 configuration
parameter is in effect. In environments with VENDOR in effect, NetBackup ignores
the information that pertains to these commands.

Whether to specify ARCFUNC SAVE or ARCFUNC COPY depends on the amount of
user intervention you intend to provide.

Determine which command to use, as follows:

■ If you specify ARCFUNC SAVE, NetBackup backs up the archive logs according
to the policy and schedule you specify.
If DB2 later issues a ROLLFORWARD request, the user exit program looks for the
archive logs on a backup volume. At restoration time, no user intervention is
required. The sequential recovery can be slow if there are numerous, large log
files.

■ If you specify ARCFUNC COPY, NetBackup copies the archive logs to the location
that is specified on the ARCDIR statement in the db2.conf file.
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The disk to which the archive logs are copied eventually fills with archived
log files. Most users want to configure a user archive schedule so they can
archive the entire ARCDIR directory to NetBackup volumes.

This method requires some user intervention during the recovery. Specifically,
you must restore these files before the roll forward operation. Advanced users
prefer this approach because of performance and flexibility benefits.
For information about how to restore files to disk, see the NetBackup
Administrator's Guide.

DB2 objects in the backup window
Table 3-7 explains the DB2 object types displayed.

Table 3-7 DB2 database objects in the backup window

DescriptionObject

If NetBackup for DB2 is detected on the client, the browser window
displays the DB2 resource. This resource is the top-level DB2 object
in the browser. DB2 is the DB2 resource.

DB2 resource

The second-level object is a DB2 instance. An instance represents a
collection of DB2 databases.

Instance

You cannot select a database for backup directly, but by selecting all
partitions below it, you can effectively select the whole database. If
you select the database for backup, you cannot select other databases.
If you select objects within the database, you cannot select objects
within other databases at the same time.

Database

The partition is the highest selectable DB2 object. A partition
represents a collection of storage within a database in which
tablespaces are stored. Partitions contain tablespaces and log folders.
Within a database, you can select one or more partitions.

DB2 EEE/DPF environments generally consist of multiple partitions.
Other DB2 UDB environments consist of a single partition, which is
usually represented as partition zero (0).

The display includes only partitions that reside on the same NetBackup
client. It does not display other partitions on remote hosts. For more
information, see the Caution that follows this table.

Partition

A tablespace is a logical entity representing a collection of physical
storage containers. Tablespaces are comprised of containers, which
represent database storage units. A tablespace is the lowest-level DB2
object that you can select in the browser.

Tablespace
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Configuring a policy to back up the archive logs
This topic describes how to create a policy to back up the NetBackup DB2 archive
log files directly to tape. Follow these instructions if you want to use the user exit
program with the ARCFUNC SAVE command.

You do not need to perform this procedure if you use the VENDOR method to back
up your archive log files.

To configure a policy to back up the archive logs

1 Log on to the master server as administrator (Windows) or root (UNIX).

2 Start the NetBackup Administration Console .

3 If your site has more than one master server, choose the one where you want
to add the policy.

4 Create a new MS-Windows (Windows) or Standard (UNIX) policy type.

5 Specify the attributes for the policy.

6 On the Schedules tab, create a User Backup schedule.

This schedule must encompass all of the time periods during which DB2 can
call the user exit program.

No backup selections list is necessary for this policy because it has a User
Backup schedule. It is not an automatic schedule.

7 On the Clients tab, add the clients you want to back up.

The clients must have the following installed:

■ DB2

■ NetBackup DB2

If the client is installed in a NetBackup cluster, add the virtual host name to
the client list.

8 Note the name of this policy.

9 When you configure the db.conf file, specify the name of the policy you created
in this procedure.

See “Creating a db2.conf file for use with the user exit program” on page 48.

Configuring a policy to archive the archive logs
This topic describes how to create a policy to archive the NetBackup DB2 archive
log entries in the ARCDIR directory. Follow these instructions if you want to use
the user exit program with the ARCFUNC COPY command.
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When NetBackup performs an archive, it deletes the online files after are backed
up successfully.

For more information on user archive schedules, see theNetBackupAdministrator’s
Guide.

You do not need to perform this procedure if you use the VENDOR method to back
up your archive log files.

To configure a policy to back up the archive logs

1 Log on to the master server as administrator (Windows) or root (UNIX).

2 Start the NetBackup Administration Console .

3 If your site has more than one master server, choose the one on which you
want to add the policy.

4 Create a new MS-Windows (Windows) or Standard (UNIX) policy type.

5 Specify the attributes for the policy.

6 On the Schedules tab, create a User Archive schedule.

This schedule must encompass all of the time periods during which DB2 can
call the user exit program.

No backup selections list is necessary for this policy because it has a User
Archive schedule. It is not an automatic schedule.

7 Specify the clients to be backed up.

The clients must have the following installed:

■ DB2

■ NetBackup for DB2

If the client is installed in a NetBackup cluster, add the virtual host name to
the policy.

Configuring the runtime environment
Configuring the runtime environment consists of creating a db2.conf file for a
standard environment as well as a cluster environment. It also shows the
environment variables that NetBackup creates.

Creating a db2.conf file for use with the user exit program
The NetBackup for DB2 configuration file, db2.conf, consists of a series of
keywords and values. This file defines how to back up the database and the archive
logs. It must be created on each NetBackup for DB2 client.
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The installation package installed a file named db2.conf that you can customize.
The following procedures show you how to customize this file. Follow the
instructions in this section if you use the user exit program to perform backups.

To create a db2.conf file for use with the user exit program

1 Before you create the db2.conf file, you need to create the policies to back
up the archive logs and the configuration files.

See “Configuring a policy to back up the archive logs” on page 47.

See “Configuring a policy to archive the archive logs” on page 47.

See “Configuring a policy to back up the configuration files” on page 34.

2 Log on to a client computer.

3 Copy the sample db2.conf file from its location in the sample directory to its
active location.

Its location in the sample directory is as follows:

UNIX and Linux: /usr/openv/netbackup/ext/db_ext/db2/scripts

Windows: install_path\NetBackup\dbext\db2\samples

The active location for the db2.conf file is as follows:

UNIX and Linux: $DB2_Instance_Home/db2.conf

Windows: install_path\NetBackup\dbext\db2\db2.conf

4 In the db2.conf file, create an object identifier for backing up the database.

This object identifier starts with the following keyword lines:

DATABASE SAMPLE

OBJECTTYPE DATABASE

...

5 In the db2.conf file, create an object identifier for backing up the archive
logs.

The form depends on how the archive logs are backed up, as follows:

■ If you use ARCFUNC SAVE:

DATABASE SAMPLE

OBJECTTYPE ARCHIVE

POLICY WIN_TYPE_POL_LOGPOL # an MS-Windows-NT type policy

POLICY STD_TYPE_POL_LOGPOL # a standard UNIX or Linux type policy
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SCHEDULE USER_BACKUP_SCHED_LOGSCHED

In the POLICY line, specify the name of the MS-Windows or Standard policy
for backing up the archive logs.
In the SCHEDULE line, specify the User Backup schedule that you created
earlier for backing up the archive logs.

■ If you use ARCFUNC COPY:

DATABASE SAMPLE

OBJECTTYPE ARCHIVE

Windows: ARCDIR C:\MyLogs\arcdir\

RETDIR C:\MyLogs\arcdir\

UNIX and Linux: ARCDIR /home/db2inst1/arcdir

RETDIR /home/db2inst1/arcdir

In the ARCDIR line, specify the full path to the location of the archive logs.

In the RETDIR line, specify the full path to the location from which the
archive logs are retrieved. Typically, the RETDIR location is the same as
the ARCDIR location.

6 You may need to add other entries to the db2.conf file.

See “db2.conf keywords” on page 55.

7 Save and close the db2.conf file.

8 Repeat this procedure on each client computer.

See “Example db2.conf file using ARCFUNC SAVE” on page 50.

See “Example db2.conf file using ARCFUNC COPY” on page 51.

Example db2.conf file using ARCFUNC SAVE
Assume that you need to back up a database named SAMPLE and its archive logs.
USEREXIT is enabled for database SAMPLE. The policies for database SAMPLE include
the required schedules for the backups.

The policies are as follows:

■ The DB2_DB_Policy backs up the database. This policy has an application
backup schedule and an automatic backup schedule. The first definition in the
example db2.conf file specifies this policy and its application backup schedule,
which is namedDefault-Application-Backup. The automatic backup schedule
is not specified in db2.conf.
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■ The DB2_Log_Policy backs up the archive logs. This policy has a user backup
schedule named User. The second entry in the example file specifies this policy
and its user backup schedule.

DATABASE SAMPLE

OBJECTTYPE DATABASE

POLICY DB2_DB_Policy

SCHEDULE Default-Application-Backup

ENDOPER

DATABASE SAMPLE

OBJECTTYPE ARCHIVE

POLICY DB2_Log_Policy

SCHEDULE User

ARCFUNC SAVE

#ARCFUNC COPY

#ARCDIR C:\MyLogs\arcdir\

#RETDIR C:\MyLogs\arcdir\

#ARCDIR /home/db2inst1/arcdir

#RETDIR /home/db2inst1/arcdir

ENDOPER

Example db2.conf file using ARCFUNC COPY
Assume that you need to back up a database named SAMPLE and its archive logs.
USEREXIT is enabled for database SAMPLE. The policies for database SAMPLE include
the required schedules for the backups.

The policies are as follows:

■ The DB2_DB_Policy backs up the database. This policy has an application
backup schedule and an automatic backup schedule. The first definition in the
example db2.conf file specifies this policy and its application backup schedule,
which is namedDefault-Application-Backup. The automatic backup schedule
is not specified in db2.conf.

■ The ARCFUNC COPY command copies the archive logs to the ARCDIR directory.

DATABASE SAMPLE

OBJECTTYPE DATABASE

POLICY DB2_DB_Policy
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SCHEDULE Default-Application-Backup

ENDOPER

DATABASE SAMPLE

OBJECTTYPE ARCHIVE

#POLICY DB2_Log_Policy

#SCHEDULE User

#ARCFUNC SAVE

ARCFUNC COPY

ARCDIR C:\MyLogs\arcdir\

RETDIR C:\MyLogs\arcdir\

ARCDIR /home/db2inst1/arcdir

RETDIR /home/db2inst1/arcdir

ENDOPER

Creating a db2.conf file (vendor method)
The NetBackup for DB2 configuration file, db2.conf, consists of a series of
keywords and values. This file defines how to back up the database and the archive
logs. It must be created on each NetBackup for DB2 client.

The installation package installed a file named db2.conf that you can customize.
The following procedures show you how to customize this file. Follow the
instructions in this section if you use the vendor method to perform backups.

To create a db2.conf file for use with the vendor method

1 Before you create the db2.conf file, you need to create the policies to back
up the configuration files.

See “Configuring a policy to back up the configuration files” on page 34.

2 Log into a client computer.
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3 Copy the sample db2.conf file from its location in the sample directory to its
active location.

Its location in the sample directory is as follows:

UNIX and Linux: /usr/openv/netbackup/ext/db_ext/db2/scripts

Windows: install_path\NetBackup\dbext\db2\samples

The active location for the db2.conf file is as follows:

UNIX and Linux: $DB2_Instance_Home/db2.conf

Windows: install_path\NetBackup\dbext\db2\db2.conf

4 In the db2.conf file, create an object identifier for backing up the database.

This object identifier starts with the following keyword lines:

DATABASE SAMPLE

OBJECTTYPE DATABASE

. . .

5 In the db2.conf file, create an object identifier for backing up the archive
logs.

DATABASE SAMPLE

OBJECTTYPE ARCHIVE

POLICY DB2_TYPE_POL_LOGPOL # a DB2 type policy

SCHEDULE DEFAULT-APPLICATION-BACKUP

In the POLICY line, specify the name of a DB2 policy. This policy can be the
same policy that you use to back up the database.

In the SCHEDULE line, specify a Default-Application-Backup schedule.

6 You may need to add other entries to the db2.conf file.

See “db2.conf keywords” on page 55.

7 Save and close the db2.conf file.

8 Repeat this procedure on each client computer.

See “Example db2.conf file (vendor method)” on page 53.

Example db2.conf file (vendor method)
Assume that you need to back up a database named SAMPLE and its archive logs.
The VENDOR method is enabled for database SAMPLE. The policies for database
SAMPLE specify the required schedules for the backups.
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The policies are as follows:

■ The DB2_DB_Policy backs up the database. This policy has an application
backup schedule and an automatic backup schedule. The first definition in the
example db2.conf file specifies this policy and its application backup schedule,
which is namedDefault-Application-Backup. The automatic backup schedule
is not specified in db2.conf.

■ The DB2_ARCH_Policy backs up the archive logs. This policy has an application
backup schedule namedDefault-Application-Backup. The third entry in the
example file specifies this policy and its application backup schedule.

DATABASE SAMPLE

OBJECTTYPE DATABASE

POLICY DB2_DB_Policy

SCHEDULE Default-Application-Backup

ENDOPER

#DATABASE SAMPLE

#OBJECTTYPE ARCHIVE

#POLICY DB2_Log_Policy

#SCHEDULE User

#ARCFUNC SAVE

#ARCFUNC COPY

#ARCDIR /home/db2inst1/arcdir

#RETDIR /home/db2inst1/arcdir

#ENDOPER

DATABASE SAMPLE

OBJECTTYPE ARCHIVE

POLICY DB2_ARCH_Policy

SCHEDULE Default-Application-Backup

ENDOPER

Configuring bp.conf files in a cluster environment
If you configure NetBackup for DB2 in a cluster environment, you need to create
the NetBackup bp.conf files in multiple places.

Create the file in the following places:

■ In /usr/openv/netbackup/bp.conf on the physical client host. This file is the
master bp.conf configuration file.

■ In the DB2 user’s home directory on each virtual host.
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NetBackup searches for the bp.conf file in the DB2 user’s home directory first.
Specifications in the user bp.conf file override those in the master bp.conf file.

Configuring a master bp.conf file
The following procedures explain how to create a master bp.conf file on the
physical client host. This file allows other backups to be performed on the host.

To create a system-wide master bp.conf file

1 Log into the physical host.

2 Use vi(1) or another editor to open file /usr/openv/netbackup/bp.conf.

3 Set the CLIENT_NAME entry to the physical host name of the NetBackup for
DB2 client. This action allows other backups to be performed on the host.

For example:

CLIENT_NAME=client_name

4 Save and close the file.

Configuring a user bp.conf file
NetBackup options in the bp.conf file of the home directory of the DB2 instance
owner take precedence over the same options in the master bp.conf file. The
following procedure explains how to create a bp.conf file on the virtual machine
that owns the DB2 instance.

To create a system bp.conf file on the virtual host

1 Log into the machine that owns the DB2 instance.

2 Use vi(1) or another editor to open file $DB2_INSTANCE_HOME/bp.conf.

3 Add a line that sets the CLIENT_NAME entry to the virtual name of the DB2
instance.

For example:

CLIENT_NAME=client_name

4 Save and close the file.

db2.conf keywords
Rules are available on how to specify keywords in the db2.conf file.

The rules are as follows:
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■ A db2.conf file consists of a series of entries that define a policy and a schedule
that are based upon an OBJECTTYPE.

■ Specify a different POLICY name for the DATABASE object. Also specify a policy
name for ARCHIVE object when you use ARCFUNC SAVE.

■ Within a definition, OBJECTTYPE is a required keyword. POLICY is required for
the DATABASE object. It is also required for the ARCHIVE object if you use ARCFUNC
SAVE or if you use the VENDORmethod. POLICY is not required if you use ARCFUNC
COPY.

All other keywords are optional.

■ Terminate each entry with an ENDOPER keyword.

■ Within a definition, the keyword value pairs can appear in any order.

■ The keywords are not case sensitive, but their values are.

■ Entries are not nested.

■ When a pound character (#) appears in the first column, the line is treated as
a comment.

The db2.conf file accepts the keywords that are described in this topic. If VENDOR
is configured in your DB2 environment, NetBackup for DB2 ignores certain the
following keywords and keyword phrases.

The following keywords and keyword phrases are ignored:

■ ARCDIR

■ ARCFUNC SAVE

■ ARCFUNC COPY

■ PARTITIONTYPE RAW

■ RETDIR

Table 3-8 describes the keywords and values that are used.

Table 3-8 Keyword value pairs for the db2.conf file

DescriptionKeyword value

Full path to the location of the archive logs. No default.

Required if ARCFUNC COPY is also specified.
ARCDIR dir
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Table 3-8 Keyword value pairs for the db2.conf file (continued)

DescriptionKeyword value

ARCFUNC SAVE saves archive logs to/from NetBackup.

ARCFUNC COPY copies archive logs to/from
ARCDIR/RETDIR directories.

You must specify eitherARCFUNC SAVE orARCFUNC COPY

if OBJECTTYPE ARCHIVE is also specified.

ARCFUNC SAVE
ARCFUNC COPY

An alternate client Windows server. Use this option when
you restore a DB2 database from one Windows server to an
alternate client Windows server.

CLIENT_NAMEclient_name

DB2 database name. No default. Required only for alternate
restores.

DATABASE db_name

DESTALIAS specifies the database alias name of the
destination database for an alternate restore.

DESTINST specifies the instance name of the destination
instance for an alternate restore.

No default. Required only for alternate restores.

DESTALIAS src_db_name
DESTINST src_inst_name

Signals the end of a definition. Required at the end of each
definition.

ENDOPER

Specifies the DB2 node number. Do not specify this keyword
unless you operate within a DB2 Enterprise Extended Edition
(EEE) environment. Not required. No default.

NODE number

Specify OBJECTTYPE ALTERNATE to note that the
succeeding lines pertain to a performing an alternate
restore.

Specify OBJECTTYPE DATABASE or OBJECTTYPE
TABLESPACE for DB2 policies. Specify OBJECTTYPE
ARCHIVE for Standard policies (UNIX and Linux) or
MS-Windows-NT policies (Windows).

One ofOBJECTTYPE ALTERNATE,OBJECTTYPE ARCHIVE,
OBJECTTYPE DATABASE, or OBJECTTYPE TABLESPACE

is required in alldb2.conf files.OBJECTTYPE ALTERNATE

is required if you want to perform an alternate restore.

OBJECTTYPE ALTERNATE
OBJECTTYPE ARCHIVE
OBJECTTYPE DATABASE
OBJECTTYPE TABLESPACE
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Table 3-8 Keyword value pairs for the db2.conf file (continued)

DescriptionKeyword value

Specifies that NetBackup search for archive log files that
are backed up from a raw partition during a restore. Not
Required. For thePOLICY, specify the name of a DB2 policy.
This policy can be the same as the one that you use to back
up the database. In the SCHEDULE line, specify a
Default-Application-Backup schedule.

PARTITIONTYPE RAW

Name of a NetBackup policy. If not specified, NetBackup
uses the first DB2 policy that is found in the configuration
on the NetBackup master server.

If OBJECTTYPE ARCHIVE is specified, specify the name of
the MS-Windows-NT or a Standard policy. This policy is
only required if you use ARCFUNC SAVE.

If OBJECTTYPE DATABASE or OBJECTTYPE TABLESPACE

is specified, then a DB2 policy must be specified.

POLICY pol_name

Full path to the location from which the archive logs are
retrieved. No default.

Required if ARCFUNC COPY is also specified.

RETDIR dir

NetBackup schedule name in policy. The default is the first
application backup in the policy.

SCHEDULE sched_name

SRCALIAS specifies the database alias name of the source
database for an alternate restore.

SRCINST specifies the instance name of the source instance
for an alternate restore.

No defaults. Required only for alternate restores.

SRCALIAS src_db_name
SRCINST src_inst_name

NetBackup for DB2 environment variables
The NetBackup automatic scheduler creates the environment variables in the
following table when it executes a NetBackup for DB2 backup-restore template
or script. You can use the DB2_FULL, DB2_INCR, and DB2_CINC variables within a
script to specify a backup type.
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Note: Only the NetBackup backup and restore templates and scripts use the
environment variables in the following table. These variables are unknown to the
DB2 backup and restore commands. For example, the backup command and the
restore command do not process the DB2_POLICY variable. Instead, the templates
and scripts use the POLICY name. This policy is defined in the
$DB2_INSTANCE_HOME/db2.conf file (UNIX and Linux) or the
install_path\NetBackup\dbext\db2\db2.conf file (Windows).

Table 3-9 describes the DB2 environment variables.

Table 3-9 DB2 environment variables

PurposeEnvironment variable

Lets you set the permissions on a backup image at backup time. Possible values are
the following:

USER - set the permissions to 600. Only the original user who backed up the data has
access to the backup images.

GROUP - set the permissions to 660. Anyone from the same group as the original
user who backed up the data has access to the backup images.

ANY - set the permissions to 664. Anyone has access to the backup images.

If this keyword is not specified, the permissions default to 660.

You can specify the keyword in the db2.conf. For example:

DATABASE SAMPLE
OBJECTTYPE DATABASE
POLICY db2-bkup
BKUP_IMAGE_PERM USER
SCHEDULE Default-Application-Backup
ENDOPER

You can also specify the keyword by using the OPTIONS directive on the DB2 backup
command. For example:

db2 backup db sample load /usr/openv/netbackup
/bin/nbdb2.so OPTIONS BKUP_IMAGE_PERM=ANY

If you use the userexit program, no configuration parameter is available and normal
file system permission are used. If you use the stream method (LOGARCHMETH1
VENDOR:/usr/openv/netbackup /bin....), you can use the new keyword in the db2.conf
or specify the keyword in the LOGARCHOPT1 parameter in the database configuration.

For UNIX and Linux:
BKUP_IMAGE_PERM
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Table 3-9 DB2 environment variables (continued)

PurposeEnvironment variable

Name of the NetBackup for DB2 policy from which the Automatic Backup was started.
This policy name is not necessarily the same policy name that is in the db2.conf
file. This variable is set only if the backup is initiated from the server, either
automatically by the NetBackup scheduler or manually through the administrator
interface.

DB2_POLICY

Name of the NetBackup server.DB2_SERVER

Name of the NetBackup schedule. Enabled only if the backup is initiated from the
server, either automatically by the NetBackup scheduler or manually through the
administrator interface.

DB2_SCHED

Set to 1 if this backup is a scheduled backup type (Automatic Backup).DB2_SCHEDULED

Set to 1 if this backup is a user-initiated backup type (Application Backup backup).DB2_USER_INITIATED

Set to 1 for an Automatic full backup .DB2_FULL

Set to 1 for an Automatic Differential incremental backup .DB2_INCR

Set to 1 for an Automatic Cumulative incremental backup .DB2_CINC

Configuring the log on account for the NetBackup Client Service for
NetBackup for DB2 on Windows

Because the NetBackup Client Service is started by default under the SYSTEM

account, you also must give special attention to database user authentication.
The SYSTEM account does not have permission to connect to the target database
if you use OS authentication instead of passwords.

If you use OS authentication, run the NetBackup client service under an account
that has SYSADM, SYSCTRL, or SYSMAINT privileges for DB2. The account name
must comply with the DB2 naming rules.

For more information on naming rules and authentication, see your DB2
documentation.

To configure the log on account for the NetBackup Client Service

1 Open the Windows Services application.

2 Double-click on the NetBackup Client Service entry.

3 Click on the Log On tab.

4 Type the account name with SYSADM, SYSCTRL, or SYSMAINT privileges.
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5 Type the password.

6 Click OK.

7 Stop and start the NetBackup Client Service.

8 Close the Services control panel application.

AboutNetBackup forDB2 templates and shell scripts
To perform a scheduled NetBackup for DB2 backup, you must create a template
or shell script. The template or shell script controls the backup job on the
NetBackup for DB2 client. You add this template or shell script to the Backup
Selections list in the NetBackup for DB2 policy on the master server. You can also
use the template or shell script to manually start a backup on the client.

The following describes templates and shell scripts.

The NetBackup for DB2 backup wizard creates backup templates. This
wizard is initiated from the NetBackup Backup, Archive, and Restore
interface.

See “Creating a backup template using the NetBackup for DB2 backup
wizard” on page 62.

The NetBackup for DB2 backup wizard does not support all of the
commands and options that are provided by DB2. If a template does
not provide all of the required functionality, you must write a script.

Templates

Sample backup and recovery shell scripts are installed on the client
with the NetBackup for DB2 agent. Modify these scripts to meet your
individual requirements.

Shell scripts are written by the user and must conform to DB2 syntax.
On UNIX and Linux, they must conform to the UNIX shell syntax.

See “Creating DB2 scripts manually” on page 65.

NetBackup for DB2 also provides a utility, bpdbsbdb2, that can
generate a shell script from a backup wizard template. This allows
you to create a template with the wizard and then generate a shell
script from it. You can then run the shell script or modify the shell
script further.

See “Creating shell scripts using bpdbsbdb2” on page 63.

Shell scripts

Specifying the NetBackup master server from the client
To ensure that the templates you create are saved to and run from the correct
master server, specify the master server on the client. You select the master server
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in the Backup, Archive, and Restore interface. On UNIX and Linux, you can also
define it in the bp.conf file.

To select the master server in the Backup, Archive, and Restore interface

1 In the Backup, Archive, and Restore interface, click the following sequence:.

UNIX and Linux: Actions > Specify NetBackup Machines and Policy Type

Windows: File > Specify NetBackup Machines and Policy Type

2 In the Server to use for backups and restores list, select the master server.

3 Click OK.

To use the bp.conf file to define the master server (UNIX and Linux), specify the
master server in one of the following locations:

■ $DB2_HOME/bp.conf

■ $NBU_HOME/bp.conf

Creating a backup template using the NetBackup for DB2 backup
wizard

The following procedure shows you how to browse the DB2 environment from
the Backup, Archive, and Restore interface on the NetBackup for DB2 client to
select database objects for backup. Then it shows how to access the backup wizard
to create the backup template.

Note: Because the Backup, Archive, and Restore interface only displays local or
resident partitions, templates that are created on the local client do not back up
partitions on remote hosts. Create additional templates for the other remote
partitions by running the wizard on those clients. To back up the entire EEE/DPF
configuration, specify multiple templates in the policy backup selections list.

To create a backup template by using the NetBackup for DB2 backup wizard

1 Start the Backup, Archive, and Restore interface:

■ On UNIX and Linux, issue the following command:
/usr/openv/netbackup/bin/jbpSA &

■ On the Windows Start menu, choose AllPrograms>SymantecNetBackup
> Backup, Archive, and Restore.

2 On UNIX and Linux, click the Backup Files tab.

On Windows, click the Select for Backup button.

Configuring NetBackup for DB2
About NetBackup for DB2 templates and shell scripts

62



3 In the left pane, expand the DB2 resource to view a DB2 instance hierarchy.

4 Select a node in the left pane to view details in the right pane.

When you select any parent database object, NetBackup for DB2 automatically
selects all the child objects beneath it. A description is available of the database
object types in the backup window.

See Table 3-7 on page 46.

5 After you select the DB2 objects to back up, use the NetBackup for DB2 Backup
Wizard to create a backup template for that DB2 element.

Click Actions > Backup.

The NetBackup for DB2 backup wizard displays the following screens for you
to enter information about the backup operation you want to perform:

■ Welcome

■ Database Login

■ Initial Settings

■ Backup Options

■ Template Summary

Click Help on the wizard panel for more information.

6 When you complete the wizard, the Template Complete screen appears. You
can save the template for later use, run the template immediately, or both.

Click Help for details about saving and running the template you created.

7 When you are satisfied with the template, click Finish to save, run, or save
and run the template you created.

When you run a backup template from the wizard, NetBackup performs a full
backup.

Creating shell scripts using bpdbsbdb2
bpdbsbdb2 is a NetBackup for DB2 command that initiates template-based,
user-directed backup and recovery. It also generates DB2 shell scripts from
templates created by the backup wizard.

To create a shell script, issue this command with the following options:

bpdbsbdb2 -backup -g script_file_name -t template_name

where:
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Generates a shell script from a template.

Enclose script_file_name in quotation marks (" ") if it contains
space characters. Do not use this option with this command’s -r
(for "run") option.

See “Using bpdbsbdb2 for a database restore” on page 84.

script file name

Identifies the template.

bpdbsbdb2 retrieves backup templates from a known location
on the master server. Specify only the file name.

template_name

Note: The users needs to review and customize any and all scripts that are
generated from templates. Generated scripts are intended to be modified for the
user's environment and preferences. For example, settings such as passwords or
catalog partition numbers are not generated in the template-to-script conversion,
so they require manual editing. In addition, generated scripts do not handle all
possible error and failure cases and should be used at your own risk.

Use theDB2CMD command processor to run scripts that you generated for Windows.
This processor is provided with DB2, DB2CMD C:\TEMP\SCRIPT.CMD.

An authorized DB2 user needs to run the scripts that are generated for UNIX.

The user needs to review and modify script execution permissions as desired.

For security purposes, user names and passwords are not included in generated
scripts. Add them as needed.

The DB2 QUIESCE command is generated when the Disconnectusersandprohibit
access template option is specified. However, this command fails if your version
is before DB2 V8.1.

When attempting a point-in-time restore, customize the time value. The command
DB2 RESTORE ... TAKEN AT strictly interprets the specified time and succeeds
only if a backup image with the same time exists. For more information, see your
IBM DB2 documentation. This limitation does not exist for templates, which search
for an appropriate image.

If a template enables roll-forward recovery, then roll-forward commands are
generated for all partitions that are specified in the template, whether or not that
partition is configured for roll-forward recovery.

If a script performs a roll-forward recovery, customize the DB2NODE variable. In
single partition environments, this variable can typically be empty (for example,
"DB2NODE="). In a multiple partition environment, set this variable to the catalog
partition number.
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Creating DB2 scripts manually
On UNIX and Linux, the NetBackup for DB2 installation software includes the
following scripts:

■ db2_backup

■ db2_restore

■ db2_all_backup_mpp

■ db2_all_restore_mpp

On Windows, the NetBackup for DB2 installation software includes the following
scripts:

■ db2_backup_db_offline.cmd

■ db2_backup_db_online.cmd

■ db2_restore_db.cmd

■ db2_mpp_backup_offline.cmd

■ db2_mpp_restore_db.cmd

After installation, the scripts reside in the following location:

On UNIX and Linux: /usr/openv/netbackup/ext/db_ext/db2/scripts

On Windows: install_path\NetBackup\dbext\db2\samples\

Modify these scripts for your environment. Do not store your scripts in the sample
directory because they are lost if you upgrade or reinstall. Always relocate your
scripts to a safe location. For clustered environments, this location must be
available after a failover.

Although each script can have multiple DB2 commands operations, a separate
script is required for each type of operation. For example, you need separate
scripts for backups and restores.

Note: Always specify the correct script when configuring automatic backups or
when starting operations through NetBackup. NetBackup for DB2 does not generate
an error if a restore script is used for a backup operation or a backup script is used
for a restore operation.

Modifying DB2 backup and install scripts
The follow procedure describes how to modify scripts. Special configuration is
required for a DB2 EEE (DPF) environment.
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See “Overview of installation and configuration for a DB2 EEE (DPF) environment”
on page 139.

To modify the DB2 backup and install scripts

1 Copy the example scripts to a different directory on your client in a safe
location. In clustered environments, this location should be available after a
failover.

2 On UNIX and Linux, set the access permissions of these scripts to 775.

chmod 775 script_name

3 Use a text editor such as Notepad (Windows) or vi(1) (UNIX and Linux) to
open the script.

4 Follow the instructions in the script.

5 On UNIX and Linux, include an su - user line (user is the DB2 instance
account) in your scripts. Otherwise, the scripts do not run with the proper
permissions and environment variables.

6 Test the scripts that you just created by starting a manual backup of this
policy.

See “Testing configuration settings for NetBackup for DB2” on page 44.

Script parameters
The NetBackup for DB2 templates and scripts read parameters from the
environment when they perform backup and restore operations.

The parameters can come from the following sources:

■ Environment variables

■ UNIX and Linux: NetBackup bp.conf

■ NetBackup db2.conf

Parameters from these sources can be evaluated within the scripts. For example,
the DB2_POLICY value is the name of the policy used to perform the backup.
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About NetBackup template and shell script storage

The backup wizard saves a backup template to a location specific
to NetBackup on the current NetBackup master server. NetBackup
retrieves a backup template from the master server as part of a
backup (server-directed, scheduled, or user-directed) and runs it
on the client. A backup template is associated with a policy by
specifying its name in the policy file or script list. Because backup
templates are stored on the server in a known location,
server-directed and scheduled backups use the same copy of the
template for each client in the policy client list.

The recovery wizard saves a restore template to a user-specified
location on the client. The location that is specified should include
a fully qualified path to a directory where the user has write access.

See “Using the NetBackup for DB2 recovery wizard” on page 82.

Templates store the encrypted passwords that are decrypted at
runtime.

Template storage

DB2 scripts must reside on the NetBackup client. Backup scripts
are associated with a policy by specifying the file name (including
path) in the policy file or script list. For server-directed or
scheduled backups, each client in the policy's client list must have
a copy of the script with the same name in the same location.

See “About adding backup selections to a DB2 policy” on page 35.

The backup processes and recovery processes sometimes require
passwords for DB2 database access and system user accounts.

Shell script storage

Templates and shell scripts pertain to NetBackup for DB2
environments that are not installed in a cluster.

Refer to the template storage and shell script storage entries in
this table.

If you operate within a NetBackup cluster, make sure that the
restore templates and shell scripts reside in a file system that is
shared between all nodes in the cluster.

Template and shell
script storage in a
NetBackup cluster
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Performing backups and
restores of DB2

This chapter includes the following topics:

■ NetBackup for DB2 backup overview

■ About backups from the NetBackup master server

■ About user-directed backups

■ Using the Backup, Archive, and Restore interface to browse DB2 resources

■ About browsing DB2 backup images with bplist

■ Performing a database restore

■ About an alternate restore

NetBackup for DB2 backup overview
After you have completed installing and configuring NetBackup for DB2, you can
start DB2 backups and restores through NetBackup. You can also run DB2
commands directly.

Note: Always specify the correct DB2 script or template when configuring
automatic backups or when starting operations through NetBackup. NetBackup
for DB2 does not generate an error if a restore DB2 script file is used for a backup
operation or a backup DB2 template or script is used for a restore operation.

NetBackup for DB2 provides the following ways to perform a backup:
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■ Issue a DB2 command from the DB2 control center or command-line processor.
The DB2 BACKUP and RESTORE commands use the policies, schedules, and
settings that are specified in the following sources:

■ The NetBackup for DB2 vendor I/O library.
On UNIX and Linux, this library is named nbdb2.ext, where ext differs
depending on your platform.
On Windows, this library is named nbdb2.dll.

■ The NetBackup for DB2 configuration file. This file is named db2.conf.

■ Run a script from the operating system command line. You can create scripts
from scratch, or you can base a script on a template that you created earlier.

■ Use templates that are initiated from the template wizards or Template
Administration interface.

■ Use templates and scripts that are specified in policies. When you back up a
NetBackup policy, it uses the templates and scripts that are specified in the
policy.

The main types of DB2 backups are as follows:

A copy of the entire DB2 database or tablespace. This backup
is accomplished by issuing a DB2 BACKUP DATABASE

command. A database backup can be initiated through
NetBackup by an automatic backup of a DB2 policy, a manual
backup of a DB2 policy, or a user-directed backup.

See “About backups from the NetBackup master server”
on page 71.

See “About user-directed backups” on page 71.

database copy

An archive log backup is a backup of an archive log file for
DB2. If VENDOR is enabled in the DB2 configuration files,
NetBackup for DB2 backs up the archive logs along with the
database files. If the user exit program is enabled in the DB2
configuration file, you need a separate policy and schedule
to back up the archive logs.

archive log backup

A configuration file backup is a backup of the DB2
configuration files that you need to recover the database in
the case of a disaster.

You can use a Standard policy (UNIX and Linux) or Windows
policy with a User Backup schedule to back up the files.

For information on which files to back up, see your IBM DB2
documentation.

database copy
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About backups from the NetBackup master server
You can back up a DB2 policy manually or automatically. To back up manually,
the administrator on the master server uses the NetBackup administrator’s
interface to execute an Automatic Backup schedule for a DB2 policy.

The most convenient way to back up a DB2 policy is to set up schedules for
automatic backups. When the NetBackup scheduler invokes a schedule for an
automatic backup, the DB2 scripts run in the same order as they appear in the
file lists and on all clients that are listed in the client list.

The DB2 scripts initiate the database backup.

Further information is available on how to add a new schedule or change an
existing schedule for automatic backups.

See “About adding schedules to a NetBackup for DB2 policy” on page 39.

When a backup template is run from a NetBackup schedule, the schedule
determines the backup type (automatic full, automatic cumulative incremental,
or automatic differential incremental).

The following information applies only if you use the user exit program to back
up the archive logs:

■ If an online backup of a partition is requested, the user exit program must be
enabled. If not, an offline partition backup is attempted. An offline backup is
also attempted if the database is in backup-pending mode.

■ If a tablespace backup is requested, the user exit program must be enabled. If
not, template execution fails because DB2 does not support offline tablespace
backups.

About user-directed backups
When you run a template, NetBackup for DB2 processes database partitions
sequentially in the order that is listed in the template summary. All tablespaces
that reside in the same partition are processed together.

For example, tablespace T1 resides in partition P1, and tablespaces T2 and T3 reside
in partition P2. The processing order is as follows:

■ Process tablespace T1 in partition P1.

■ Process tablespaces T2 and T3 in partition P2.

You can run a user-directed backup in the following ways:

■ Using the DB2 template administration interface
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■ Using bpdbsbdb2.

■ Using DB2

A failure in processing a request immediately stops template execution. The error
condition must be resolved before the template can be re-run. Except where noted,
all DB2 warnings are treated as DB2 errors; they cause template execution to fail.

If the Disconnectusersandprohibitaccess template option is selected, the system
issues the DB2 QUIESCE command before it performs the backup or restore.

Users must have sufficient DB2 permissions to browse DB2 databases and perform
backup, restore, and roll-forward operations. Refer to the following DB2 database
manager configuration settings: SYSADM, SYSCTRL, and SYSMAINT.

Using the DB2 template administration interface to run a user-directed
backup

The DB2 template administration interface is available in the NetBackup Backup,
Archive, and Restore interface. The DB2 template administration window provides
the following functions:

Processes the selected template.Run

Changes the contents of an existing template. The selected template
is loaded into the NetBackup for DB2 template generation wizard.

Edit

Removes the selected template. You must be the root user or the
template creator to delete a template.

Delete

Changes the name of the selected template. You must be the root user
or the template creator to rename a template.

Rename

Displays a summary of the selected template.View

The templates that are created by the NetBackup for DB2 template generation
wizard are stored in a predetermined location on the master server.

See “Creating a backup template using the NetBackup for DB2 backup wizard”
on page 62.
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To use the DB2 template administration interface

1 Start the NetBackup Backup, Archive, and Restore interface.

On UNIX and Linux, type the following from the command line:

/usr/openv/netbackup/bin/jbpSA &

On Windows, choose File > Backup, Archive, and Restore in the NetBackup
Administration Console.

2 In the Backup, Archive, and Restore interface, choose Actions > Administer
Database Templates > DB2.

The DB2 Template Administration window appears.

The Select Template list shows the names and descriptions of the DB2 backup
templates that are stored on the current master server.

3 Select the name of the backup template you want to run.

4 Click Run.

5 Type your User Name and Password.

6 Click OK.

7 Click Run.

The template runs a full backup. Incremental backups are only available
through the NetBackup scheduler.

You can use the View Status tool to see the status of the backup. Click File >
View Status.

Using bpdbsbdb2 to run a user-directed backup
The bpdbsbdb2 command runs a backup template that is created by the NetBackup
for DB2 Backup Wizard. At the command prompt, issue bpdbsbdb2 in the following
format:

# bpdbsbdb2 -backup -r -t template_name -i instance_name

Where -r runs a template, -t identifies the template, and -i identifies the instance
to use.

For example:

# bpdbsbdb2 -backup -r -t DB2_Mon_full.tpl -i DB2INST

bpdbsbdb2 retrieves backup templates from a predetermined location on the
master server, so you only need to specify the template file name.
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Using DB2 to run a user-directed backup
To start a user-directed backup, run the DB2 BACKUP DATABASE command.

You can run this command from the DB2 command line on the client (UNIX and
Linux) or from the DB2 command window on the client.

Depending on the release of DB2 that you use, issue the BACKUP DATABASE

command in one of the following formats to perform a backup.

Table 4-1 BACKUP DATABASE command formats

DescriptionFormat

Issue the command in the following format:

UNIX and Linux: db2 backup db sample load \
/usr/openv/netbackup/bin/lib

The specification for lib differs depending on your platform.

Windows: db2 backup db sample load

install_path\NetBackup\bin\nbdb2.dll

The db2.conf specifies several variables that the backup
operation uses. You can override the policy name and schedule
name variables directly on the command line by using the
OPTIONS entry. The following example overrides the policy name
and the schedule name:

UNIX and Linux: db2 backup db sample load

/usr/openv/netbackup/bin/lib OPTIONS

"DB2_POLICY=policy3:DB2_SCHED=sched_name4"

See “About the NetBackup for DB2 components” on page 16.

Windows: db2 backup db sample load

install_path\NetBackup\bin\lib OPTIONS

"DB2_POLICY=policy3:DB2_SCHED=sched_name4"

Supported in all DB2
releases
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Table 4-1 BACKUP DATABASE command formats (continued)

DescriptionFormat

If you use a DB2 8.2 or later release and if VENDOR is enabled, you
can use the command in the following format:

UNIX and Linux: db2 backup db sample online load

/usr/openv/netbackup/bin/lib include logs

For lib, specify the same path as shown for the preceding format
(Format 1).

Windows: db2 backup db sample online load

install_path\NetBackup\bin\nbdb2.dll include logs

The db2.conf file specifies several variables that the backup
operation uses. You can override the policy name and schedule
name variables directly on the command line by using the
OPTIONS entry. The following example overrides the policy name
and the schedule name:

UNIX and Linux: db2 backup db sample online load

/usr/openv/netbackup/bin/libinclude logs OPTIONS

"DB2_POLICY=policy3:DB2_SCHED=sched_name4"

Windows: db2 backup db sample online load

install_path\NetBackup\bin\libinclude logs OPTIONS

"DB2_POLICY=policy3:DB2_SCHED=sched_name4"

For more information on the DB2 BACKUP DATABASE command,
see your DB2 documentation.

Supported in DB2 8.2
and later releases

BACKUP DATABASE command options
You can back up a DB2 database to NetBackup with either the DB2 BACKUP

DATABASE command or with its alternative syntax, BACKUP DB.

Table 4-2 lists the command options when used in a NetBackup for DB2
environment.

Table 4-2 DB2 BACKUP command options

PurposeOption

Instructs DB2 to use the NBDB2 vendor library when it
performs the backup.

LOAD NBDB2_library_path
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Table 4-2 DB2 BACKUP command options (continued)

PurposeOption

Specifies the number of concurrent data streams used
for writing data. Use this option if you have multiple
backup devices available, or you have multiplexing
enabled in NetBackup.

OPEN number SESSIONS

Use this option when opening multiple sessions. See
OPEN number SESSIONS. The number of buffers must
be twice the number of sessions.

WITH number BUFFERS

Use this option to increase or decrease the buffer size,
if necessary. Increased size can benefit performance,
but decreased size might be necessary if using numerous
buffers. DB2 recommends that the size be a multiple of
the extent size. The DB2 DFT_EXTENT_SZ setting
defines the default extent size.

BUFFER size

This option is required for unattended backups. It must
be specified in backup scripts that NetBackup executes.

WITHOUT PROMPTING

Use this option to perform a cumulative backup.INCREMENTAL

Use this option to perform a differential backup.INCREMENTAL DELTA

Use this option to back up hot, or active, databases. The
DB2 USEREXIT setting must be enabled for online
backups.

ONLINE

Specifies options that are to be used for the backup
operation. The string passes to the vendor support
library, for example TSM, exactly as it was entered,
without the quotes.

Specifying this option with the DB2_POLICY,
DB2_SCHED, BKUP_IMAGE_PERM, or
DB2_RESTORE_PRIORITY environment variables
overrides their settings in the db2.conf file.

See Table 3-9 on page 59.

Note: Specifying this option overrides the value that
is specified by the VENDOROPT database configuration
parameter.

OPTIONS "options-string"
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Table 4-2 DB2 BACKUP command options (continued)

PurposeOption

Determines the number of tablespaces which can be
read in parallel by the backup utility. DB2 automatically
chooses an optimal value for this parameter unless you
explicitly enter a value.

PARALLELISM n

Using the Backup, Archive, and Restore interface to
browse DB2 resources

The Backup, Archive, and Restore interface displays the DB2 resource. You can
browse the DB2 resources through four levels: instance, database, partition, and
tablespace. You can view the containers in a tablespace, but you can select for
restore only at the tablespace level or the partition level.

Note:You can also use the DB2 LIST HISTORY command to browse backup images.

This interface does not let you browse previous backups. Instead, it browses the
existing DB2 instances and databases. You can select these DB2 objects and use
the NetBackup for DB2 recovery wizard to prepare recovery templates for the
objects.

See “Using the NetBackup for DB2 recovery wizard” on page 82.

The following shows a sample restore window in the Backup, Archive, and Restore
interface for UNIX and Linux, and for Windows.
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Figure 4-1 Restore window (UNIX and Linux)

Figure 4-2 Restore window (Windows)

In this example, the DB2 resource is expanded down to the tablespace level. You
can select for restore one or more tablespaces, one or more partitions, or one
entire database (by selecting all of its partitions).

Performing backups and restores of DB2
Using the Backup, Archive, and Restore interface to browse DB2 resources

78



About browsing DB2 backup images with bplist
You can use the bplist command to search DB2 backup images. The output from
bplist differs depending on how you manage your archive log files.
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Table 4-3 bplist output

Descriptionbplist option

This example searches all DB2 backup images for a client named camel, which is also the
master server. The information comes from the NetBackup catalog on the master server. The
user exit program backs up the archive files.

The bplist -t 18 option specifies the DB2 backup type. The bplist output shows the DB2
database backup images that are stored in the NetBackup database

UNIX and Linux:

/usr/openv/netbackup/bin/bplist -C camel -S camel -t 18 -R /
/DB2/SAMP/node0000/2009120210515/SAMP.0.DB2.node0000.0.2009120210515.1
/DB2/SAMP/node0000/2009120210473/SAMP.0.DB2.node0000.0.2009120210473.1
/DB2/SAMP/node0000/2009112915411/SAMP.3.DB2.node0000.4.2009112915411.1

Windows:

install_path\NetBackup\bin\bplist -C camel -S camel -t 18 -R /
DB2:\SAMP\node0000\2009120210515\SAMP.0.DB2.node0000.0.2009120210515.1
DB2:\SAMP\node0000\2009120210473\SAMP.0.DB2.node0000.0.2009120210473.1
DB2:\SAMP\node0000\2009112915411\SAMP.3.DB2.node0000.4.2009112915411.1

Where:

DB2 is the directory name for all DB2 backups.

SAMP is the name of the database (both occurrences).

node0000 is the node name.

20091202105150 is the time that the backup occurred.

0 is the type of backup taken. Zero (0) indicates a full database backup. Three (3) indicates a
tablespace backup.

DB2 is the database instance name. It is one to eight characters in length.

node0000 is the node number. In non-partitioned database systems, the node number is always
zero (node0000). In partitioned database systems, the number is nodexxxx, where xxxx is the
number assigned to the node in the db2nodes.cfg file.

0 is the last archive log number.

20091202105150 is the timestamp, which includes the date (year, month, day) and time (hour,
minute, second).

1 is the session number. This file extension identifies the session number that was specified
on the DB2 BACKUP command.

-t 18
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Table 4-3 bplist output (continued)

Descriptionbplist option

This example searches all DB2 backup images for a client named cow, which is also the master
server. The information comes from the NetBackup catalog on the master server. This example
assumes that the user exit program is used to back up the archive files.

The -k DB2_Log_Policy option specifies files that are backed up with this policy. The policy
name originates from the settings in thedb2.conf file for archive log files. Thebplist output
shows the list of DB2 archive log files that are stored in NetBackup.

UNIX and Linux:

/usr/openv/netbackup/bin/bplist -k DB2_Log_Policy -C cow -S cow -R /
/home/db2inst/NODE0000/SQL00001/SQLOGDIR/S0000026.LOG
/home/db2inst/NODE0000/SQL00001/SQLOGDIR/S0000025.LOG
/home/db2inst/NODE0000/SQL00001/SQLOGDIR/S0000024.LOG

Windows:

install_path\NetBackup\bin\bplist -k DB2_Log_Policy -C cow -S cow -R /
C:\DB2\NODE0000\SQL00001\SQLOGDIR\S0000026.LOG
C:\DB2\NODE0000\SQL00001\SQLOGDIR\S0000025.LOG
C:\DB2\NODE0000\SQL00001\SQLOGDIR\S0000024.LOG

-k

DB2_Log_Policy

This example uses bplist to search the DB2 archive log files for a client named cow. The -k
log_policy option specifies files that are backed up with this policy. The VENDOR is set and
the user exit program is not used to back up the archive logs:

UNIX and Linux:/usr/openv/netbackup/bin/bplist -C cow -S cow -k log_policy

-R /

/DB2/SAMPLE/LOGFILE/node0000/db2v864d/C0000000_S0000000.LOG

Windows: install_path\NetBackup\bin\bplist -C cow -S cow -k log_policy

-R /

C:\DB2\SAMPLE\LOGFILE\node0000\db2v864d\C0000000_S0000000.LOG

Where:

DB2 is the directory name for all DB2 backups.

SAMPLE is the name of the database.

LOGFILE identifies the entry as a log file.

node0000 is the node name.

db2v864d is the name of the DB2 instance.

C0000000_S0000000.LOG is the name of the log file that is provided by DB2.

-k log_policy

81Performing backups and restores of DB2
About browsing DB2 backup images with bplist



You can find more information on the bplist command in the NetBackup
Commands Reference Guide.

Performing a database restore
As the DB2 user on UNIX and Linux, you can initiate a database restore with the
DB2 Control Center or command-line processor.

On UNIX and Linux, a NetBackup task can execute a restore template or script
containing the necessary DB2 commands to perform the restore. You can use the
NetBackup for DB2 recovery wizard to create restore templates, or write scripts
that contain the commands to perform a restore.

Using the NetBackup for DB2 recovery wizard
NetBackup for DB2 includes a recovery wizard that solicits information from the
user about the desired DB2 restore and recover operations. The wizard uses the
information to create a template that can be used immediately or saved for later
use.

The NetBackup for DB2 recovery wizard saves a recovery template locally in a
user-specified location on the NetBackup client. Recovery templates are not stored
on the server because recovery is always user directed, not scheduled. Under
typical circumstances, a recovery template is run immediately and then deleted.

The recovery process sometimes requires passwords for DB2 database access and
system user accounts. Templates store encrypted passwords that are decrypted
at runtime.

Because recovery can be a complex process, it might be necessary to perform
manual steps as part of the operation. For more information, see your DB2
documentation.

Selecting files for restore
The following procedure describes how to select files for a restore operation.

To select files for restore

1 Open the Backup, Archive, and Restore interface.

2 On Windows, click File > Specify NetBackup Machines and Policy Type.

On UNIX and Linux, click Actions > SpecifyNetBackupMachinesandPolicy
Type.

3 In the Policy type for restores list, select DB2.
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4 Click OK.

5 On UNIX and Linux, Click the Restore Files tab.

On Windows, click Choose File > Select Files and Folders to Restore > from
Normal Backup.

6 Expand the DB2 resource in the left pane to view a DB2 instance hierarchy.

7 Select a node in the left pane to view details in the right pane.

If the DB2 node is not visible, it is possible that your NetBackup for DB2 client
does not have the appropriate policy type specified.

Using the recovery wizard
When you are ready to perform a recovery, complete the following procedure to
create and run a template with the recovery wizard. When you run a template,
all restore operations are performed before any and all roll-forward operations.

Note the following:

■ When you perform a DB2 restore, false alarms are reported in the NetBackup
Activity Monitor. DB2 accesses the NetBackup image twice when you perform
a restore. The first access reads a partial image, which is reported as "The
restore failed to recover the requested files" (status 5) in the Activity Monitor.
The next access reads the entire image, which should result in a successful
restore (status 0). The template execution status, not the activity monitor, is
the best indication of overall success.

■ DB2 warning SQL2539W indicates that the requested restore operation replaces
the existing database. That is, the existing database files are deleted. When
running a template to perform a restore, this warning is logged and the restore
proceeds without interruption.

■ DB2 warning SQL2523W indicates that the backup image originates from a
different database of the same name. This warning is handled as an error to
prevent DB2 from deleting log files.

■ DB2 error SQL1260N indicates that the restored partition is not configured
for roll-forward recovery. If the template is configured to perform a
roll-forward, this step is skipped.
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To use the recovery wizard

1 Log onto NetBackup as the DB2 user.

2 In the Backup, Archive, and Restore interface, do one of the following:

UNIX and Linux: Click the Restore Files tab.

Windows: Choose File > Select Files and Folders to Restore > from Normal
Backup

3 Expand a DB2 instance and select the database objects you want to restore.

4 UNIX and Linux: Click Restore.

Windows: Click Actions > Restore

5 Enter information about the restore operation you want to perform in the
following screens:

■ Welcome

■ Database Login

■ Time Periods

■ Restore Options

■ Recovery Options

If you need an explanation of any of the fields on the wizard screens or more
details, click Help on the wizard screen.

6 Run the template immediately after the wizard finishes, to save the template
locally, or both. For explanations of your choices, click Help.

Template execution does not support the use of local time when performing
a roll-forward. The roll-forward time that is specified in the template is passed
to DB2, and it is interpreted as GMT by DB2. For more information, see the
ROLLFORWARD command in your DB2 documentation.

Using bpdbsbdb2 for a database restore
The bpdbsbdb2 command lets you run a recovery template that the NetBackup
Recovery wizard creates.

At the command line, type the following:

UNIX and Linux: /usr/openv/netbackup/bin/bpdbsbdb2 -restore -r -t

template_name -i instance_name

Windows:install_path\netbackup\bin\bpdbsbdb2 -restore -r -t templ_name

-i instance_name
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The -r runs a template, and the -t identifies the template.

For example:

UNIX and Linux: /usr/openv/netbackup/bin/bpdbsbdb2 -restore -r \ -t

/db2/restore_templates/full_restore.tpl -i DB2INST

Windows: bpdbsbdb2 -restore -r -t

\db2\restore_templates\full_restore.tpl -i DB2INST

Restore templates do not reside in a predetermined location on the master server.
They are considered to be temporary in nature and should reside on the client. If
the full path is not specified as part of the restore template name, the file might
not be found.

You can create a script from a template with bpdbsbdb2.

Using DB2 to perform a restore
The exact process for recovering a DB2 database differs from site to site depending
on the following: the methods that are used for backing up the archive logs, the
settings that are used in the NetBackup for DB2 configuration file, db2.conf, and
the location of the archive logs.

The following procedures show how to restore an example database to the level
of a recent database backup plus archive logs:

■ See “Recovering a DB2 database - Simplest case” on page 85.
Use this procedure if the archive logs are in an accessible location and they
were all created with the same parameters in db2.conf.

■ See “Recovering a DB2 database - Restoring archive logs” on page 86.
This case is more complex. Use this procedure if you have to browse for archive
logs and restore them from secondary storage.

For more information on how to recover a DB2 database, see your DB2
documentation.

Recovering a DB2 database - Simplest case
The DB2 commands for recovering a database differ from release to release. Use
this procedure to restore a database if the archive logs are in a location that is
known and accessible to DB2 and NetBackup.

For example, you can probably use the procedure in this section if the following
are true:

■ If ARCFUNC SAVE was in effect in the db2.conf file when all archive logs were
backed up.
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■ If ARCFUNC COPY was in effect in the db2.conf file when all archive logs were
backed up and the logs were not moved from theARCDIR andRETDIRdirectories.

■ If VENDOR was in effect in DB2 at the time all the archive logs were created.

The commands in the following procedure restore a DB2 database and its archive
logs. These commands assume that the archive log files reside in a location that
is known and accessible to DB2 and NetBackup.

To restore a DB2 database when the archive logs are accessible to DB2 and
NetBackup

◆ Depending on the release level of DB2, enter one of the following commands:

■ For DB2 8.2 and later releases, enter the following command:
db2 recover db db_name

■ For DB2 releases before 8.2, enter the following commands:
Windows: db2 restore db db_name load

install_path\NetBackup\bin\nbdb2.dll db2 rollforward db db_name

to end of logs and stop

Where db_name is the name of the DB2 database you want to restore.
UNIX and Linux: db2 restore db db_name load

/usr/openv/netbackup/bin/libdb2 rollforward db db_name to end

of logs and stop

Where:

Name of the DB2 database.db_name

Full path to the NBDB2 library.

See “About the NetBackup for DB2 components” on page 16.

lib

Recovering a DB2 database - Restoring archive logs
You can use the procedure in this section if you need to restore the archive logs
before you perform the roll-forward.

Use the procedure in this section to restore the archive logs manually if the
following situations exist:

■ If the archive logs are not in the standard locations. When this situation exists,
NetBackup cannot perform a seamless restore of DB2. You may have moved
one or more of the needed archive logs to secondary storage such as tape,
network storage, or some other location. For example, if ARCFUNC COPY is in
effect and the old archive logs were moved to tape, perform procedure in this
section.
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■ If ARCFUNC COPY was in effect in the db2.conf file at the time the archive logs
were backed up and the ARCDIR and RETDIR parameters specify two different
locations.

■ If PARTITIONTYPE RAW was in effect in the db2.conf file for some (not all) of
the archive log backups.

For more information about the DB2 commands, see your DB2 documentation.

To restore a DB2 database when the archive logs are in a non-standard location

1 Restore the database.

Issue the DB2 RESTORE DATABASE command to restore the database itself. For
example:

Windows: db2 restore db db_name load

install_path\NetBackup\bin\nbdb2.dll

where db_name is the name of the DB2 database you are to restore.

UNIX and Linux: db2 restore db db_name load

/usr/openv/netbackup/bin/lib

Where:

Name of the DB2 database.db_name

Full path to the NBDB2 library.

See “About the NetBackup for DB2 components” on page 16.

lib

2 Use NetBackup to browse the archive logs.

If a restore requires log files that are backed up from a file system and log
files that are backed up from a raw device, retrieve the logs from the file
system manually.

You can use the Backup, Archive, and Restore interface or the bplist

command to browse the archive logs and find those missing from the restore
directories.

If PARTITIONTYPE RAW is specified in the db2.conf file, the user exit program
looks for only those logs when you perform the restore. The missing logs are
those that were written when PARTITIONTYPE RAW was not in effect.

See “Using the Backup, Archive, and Restore interface to browse DB2
resources” on page 77.

See “About browsing DB2 backup images with bplist” on page 79.
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3 Use operating system commands to copy the missing archive logs to the
correct locations in your operating system. For example:

On UNIX and Linux, use the cp command.

On Windows, use your mouse to copy the files from one location to another.

If ARCFUNC COPY is in effect and the ARCDIR and RETDIR parameters specify
different locations, copy the logs in the ARCDIR directory to the RETDIR

directory. If ARCDIR and RETDIR specify the same location, you do not have
to take any action. If some of the log files have been moved to secondary
storage, restore these files to the RETDIR directory.

4 Use NetBackup to restore the archive logs.

Use either the NetBackup Backup, Archive, and Restore interface or the
bprestore command. For example:

UNIX and Linux: bprestore
/vedb2/db2/v8/db2V82d/NODE0000/SQL0001/SQLOGDIR/S00009.LOG

Windows: bprestore
C:\vedb2\db2\v8\db2V82d\NODE0000\SQL0001\SQLOGDIR\S00009.LOG

5 Bring the database online.

When the roll-forward is initiated, DB2 sends a request to NetBackup to
restore the log files it needs. DB2 then reapplies the transaction information
in the archive logs since the last full backup was performed. DB2 brings back
the database online.

For example, you can use the following command options if PARTITIONTYPE
RAW was not specified when any of the log files were backed up:

db2 rollforward db sample to end of logs and stop

The ROLLFORWARD DATABASE command issues messages if it cannot locate all
the archive log files it needs. If you receive these messages, browse and restore
the missing archive log files, and issue the ROLLFORWARD DATABASE command
again.

After the database is successfully restored, the ROLLFORWARD DATABASE

command restores and reapplies the transactions that are recorded in the
archive log files since the last backup was performed. For example, if the
backup image was created 10 days ago and restored today, the log files are
used to restore transactions that occurred after the backup.
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RESTORE DATABASE command options
You can restore a DB2 database with either the DB2 RESTORE DATABASE command
or with its alternative syntax, RESTORE DB. The DB2 RESTORE DATABASE command
restores a database from NetBackup.

Table 4-4 provides reference information for the command options when used in
a NetBackup for DB2 environment.

Table 4-4 DB2 RESTORE command options

PurposeOption

Instructs DB2 to use the NBDB2 vendor library when
you perform the restore.

LOAD NBDB2_Library_Path

Specifies the number of concurrent data streams used
for writing data. Use this option if you have multiple
backup devices available or if you have multiplexing
enabled in NetBackup.

Typically, you should specify the same number of
sessions that were used during the backup. You can use
fewer sessions, but it may degrade overall restore
performance. No benefit exists if you specify more
sessions.

OPEN number SESSIONS

Use this option when opening multiple sessions. See
OPEN number SESSIONS.

The number of buffers must be twice the number of
sessions. If you use fewer buffers it can degrade
performance or can cause the restore to fail when it
reads multiplexed images.

WITH number BUFFERS

Use this option to increase or decrease the buffer size
if necessary. Increased size can benefit performance,
while decreased size may be necessary if you use
numerous buffers. DB2 alters the actual size to be a
multiple of the size that is used during the backup.

BUFFER size

This option is required for unattended restores, and it
must be specified in backup scripts that are executed
by NetBackup.

WITHOUT PROMPTING

When you use this option, DB2 may not read the entire
image from NetBackup media. Consequently, NetBackup
logs an error in the activity monitor, which can safely
be ignored.

INCREMENTAL
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Table 4-4 DB2 RESTORE command options (continued)

PurposeOption

Use this option to restore a series of full and incremental
images.

An automated restore coordinates the restoration of a
full backup and all associated incremental backups. A
single automated restore restores a full backup, an
optional cumulative incremental backup, and one or
more differential incremental backups.

AUTOMATIC

When you use this option, DB2 may not read the entire
image from NetBackup media. Consequently, NetBackup
logs an error in the activity monitor, which can safely
be ignored.

HISTORY FILE

Specifies options to be used for the restore operation.
The string passes to the vendor support library, for
example TSM, exactly as it was entered, without the
quotes.

Specifying this option overrides the value that is
specified by the VENDOROPT database configuration
parameter.

OPTIONS "options-string"

Specifies the number of buffer manipulators that are
to be spawned during the restore operation. DB2
automatically chooses an optimal value for this
parameter unless you explicitly enter a value.

PARALLELISM n

Allows the user to explicitly specify the media server
to be used to perform the restore.

DB2_MEDIA_SERVER

Allows the user to explicitly specify the copy number
to be used to perform the restore.

DB2_COPY_NUMBER

About an alternate restore
An alternate restore lets you restore a DB2 database to a different client or to a
different instance. You can also change the name of the database during the
restore.

Alternate restores differ from regular restores as follows:

■ Use the regular restore procedures if you want to restore a database into the
same instance on the same NetBackup client that hosted it previously. In this
case, the database also retains its original name.
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■ Use alternate restore procedures if you want to restore a database to a different
instance or to a different client or if you must rename the database during the
restore.
Databases within an instance must have unique names. If you restore a database
into an instance that already has a database by that name, the alternate restore
process overwrites the existing database.

Table 4-5 summarizes the types of restores you can perform and whether you
need to use regular or alternate restore procedures.

Table 4-5 Types of restores permitted

Alternate
restore

Alternate
restore

Alternate
restore

Alternate
restore

Alternate
restore

Alternate
restore

Alternate
restore

Regular
restore

Object

DifferentDifferentDifferentSameDifferentSameSameSameDatabase
name

DifferentSameDifferentDifferentSameDifferentSameSameInstance

DifferentDifferentSameDifferentSameSameDifferentSameClient

For example, assume that you have two NetBackup clients, grade7 and grade8.
Instances class1 and class2 are on grade7. Instance class1 is on grade8.

Figure 4-3 illustrates this example.

Figure 4-3 Alternate restore example

Client: grade7

Instance: class1

Databases: math1,art1

Instance: class2

Databases: eng1, art1

Client: grade8

Instance: class1

Databases: math1, art10

The following list shows some of the types of restores you can perform with
alternate restore procedures:

■ You can restore database eng1 from instance class2 on client grade7 into
instance class1 on client grade8. Database eng1 can retain its name because
it is unique to instance class1.

■ You can restore database math1 from instance class1 on client grade7 into
instance class1 on client grade8. During the restore, you need to rename
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math1 to math2 because class1 on grade8 already has a database named math1.
Without renaming, the existing database math1 would be overwritten.

■ You can restore database art1 from instance class2 on client grade7 into
instance class1 on client grade7. During the restore, you need to rename art1
to art2 because instance class1 already has a database named art1. Without
renaming, the existing database art1 would be overwritten.

Preparing the master server for an alternate restore
The examples in the following procedure assume that database SAMPLEwas backed
up by client2, and you want to restore SAMPLE to client1.

For more information on how to manage client restores, see the NetBackup
Administrator’s Guide.

To prepare the NetBackup master server for alternate restores

1 Log onto the NetBackup master server that hosts the policy that backed up
database SAMPLE.

2 Create one of the following files on the NetBackup master server:

■ UNIX and Linux:/usr/openv/netbackup/db/altnames/No.Restrictions

■ UNIX and Linux:/usr/openv/netbackup/db/altnames/dest_client_name

■ Windows: install_path\NetBackup\db\altnames\No.Restrictions

■ Windows: install_path\NetBackup\db\altnames\dest_client_name

Where dest_client_name is the name of a client that is allowed to be a
destination client for alternate restores. For example, client1.

3 If you created adest_client_name file, add the name of the NetBackup for DB2
source client to the dest_client_name file. For example, add the following line
to this file:

client2

For more information on managing client restores, see the NetBackup
Administrator's Guide.

Performing the alternate restore on the clients
The following procedures explain how to restore a DB2 database and its transaction
logs. The procedure builds a request to DB2 to find the backup images that
correspond to the database you try to restore. Type the commands in this
procedure from the client that receives the restored database.
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To perform an alternate restore of a DB2 database

1 Modify the db2.conf file on the destination client.

Add the following new object identifiers:

■ One to specify the alternate restore

■ One to define the new database

■ One to define the old database

■ One to define the new log files

■ One to define the old log files

The following example shows the keyword lines that are needed to specify
the alternate restore:

OBJECTTYPE ALTERNATE # Specifies an alternate restore

SRCINST db2v832d # Names the source instance that was backed up

SRCALIAS SAMPLE # Names the source database that was backed up

DESTINST db2v832t # Names the destination instance name

DESTALIAS NEWSAMPL # Names the destination database alias name

ENDOPER # Ends the object identifier

The following example shows the keyword that are needed to define the new
database:

DATABASE NEWSAMPL

OBJECTTYPE DATABASE

POLICY db2-bkup

SCHEDULE Default-Application-Backup

CLIENT_NAME Client1

ENDOPER

The following example shows the keyword that are needed to define the old
database:

DATABASE SAMPLE

OBJECTTYPE DATABASE

POLICY db2-bkup

SCHEDULE Default-Application-Backup

CLIENT_NAME Client1

ENDOPER

The following example shows the keyword that are needed to define the new
data archive log files:
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DATABASE NEWSAMPL

OBJECTTYPE ARCHIVE

POLICY db_a_db2

SCHEDULE Default-Application-Backup

#SCHEDULE User

CLIENT_NAME Client1

ARCFUNC SAVE

#ARCFUNC COPY

#ARCDIR /home/db2inst1/arcdir

#RETDIR /home/db2inst1/arcdir -- (UNIX and Linux)

#ARCDIR C:\home\db2inst1\arcdir

#RETDIR C:\home\db2inst1\arcdir -- (Windows)

ENDOPER

The following example shows the keyword that are needed to define the old
data archive log files:

DATABASE SAMPLE

OBJECTTYPE ARCHIVE

POLICY db_a_db2

SCHEDULE Default-Application-Backup

#SCHEDULE User

CLIENT_NAME Client1

ARCFUNC SAVE

#ARCFUNC COPY

#ARCDIR /home/db2inst1/arcdir

#RETDIR /home/db2inst1/arcdir -- (UNIX and Linux)

#ARCDIR C:\home\db2inst1\arcdir

#RETDIR C:\home\db2inst1\arcdir -- (Windows)

ENDOPER

2 UNIX and Linux: Edit the bp.conf file by changing the CLIENT_NAME entry to
specify the client where the database was originally backed up. Also, change
the SERVER entry to specify the master server that hosts the policy that
originally backed up the database.

Windows: Do the following:

■ Start the Backup, Archive, and Restore interface.

■ Choose File > Specify NetBackup Machines and Policy Type.
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■ In the Specify NetBackup Machines and Policy Type dialog box, from
the Server to use for backups and restores list, select the name of the
master server that contains the policy that backed up the database.

■ From the Source client for restores list, select the client (for example,
client2).

■ From the Destination clients for restores list, select the client to which
you want to restore (for example, client1).

3 On the destination client, type the DB2 RESTORE command.

Type this command in the following format:

db2 restore db db_being_restored load lib_path into

new_db_name redirect

where:

Specify the name of the database that was backed up.db_being_restored

Specify the full path to the NetBackup library.lib_path

Specify the name for the new database. If the name of
the new database matches the name of a database
presently included in the new instance, the new database
overwrites the existing database.

new_db_name

For example:

db2 restore db sample load /opt/openv/netbackup/bin/nbdb2.sl

into newsampl redirect -- (UNIX and Linux)

db2 restore db sample load install_path\NetBackup\bin\nbdb2.dll

into newsampl redirect -- (Windows)
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4 Set the location of the data files for the tablespace.

Type this command in the following format:

db2 set tablespace containers for 0 using "(path path)"

where path specifies the DB2 install path.

For example, type one or more commands similar to the following:

db2 set tablespace containers for 0 using "(path

DB2_install_path/db2v832t/NODE0000/SQL00001/SQLT0000.0)"

-- (UNIX and Linux)

db2 set tablespace containers for 0 using "(path

DB2_install_path\db2v832t\NODE0000\SQL00001\SQLT0000.0)"

-- (Windows)

5 Restore the database.

Type the RESTORE command in the following format:

db2 restore db db_bring_restored continue

For example:

db2 restore db sample continue

6 (Optional) Restore the transaction logs.

See “Restoring the transaction logs” on page 96.

7 Use the DB2 ROLLFORWARD command to restore the logs.

Type this command in the following format:

db2 rollforward db new_db_name to end of logs and stop

Restoring the transaction logs
Perform this procedure if one of the following is true:

■ The archive logs did not originally reside on a raw device.

■ The user exit program was used to back up the archive logs.
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To restore the transaction logs

1 On the destination client, create a directory for the restored transaction log
files.

For example:

UNIX and Linux: mkdir
/db/db2_v5/home/db2inst1/NODE0000/SQL00001/SQLOGDIR

Windows: mkdir
C:\db\db2_v5\home\db2inst1\NODE0000\SQL00001\SQLOGDIR

2 Use the bprestore command to restore the logs.

For example:

UNIX and Linux:bprestore /db/db2_v5/home/db2inst1/NODE0000/SQL00001

/SQLOGDIR/S00001.LOG

Windows: bprestore install_path\db\db2_v5\home\db2inst1\

NODE0000\SQL00001\SQLOGDIR\S00001.LOG

3 If the directory into which you restored the log files is not correct for the
destination database, move the logs to the proper location.

4 Verify that the correct owner and group permissions are enabled on the log
directory.
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Using Snapshot Client with
NetBackup for DB2

This chapter includes the following topics:

■ NetBackup for DB2 with Snapshot Client features

■ About NetBackup for DB2 with Snapshot Client operations

■ About configuring Snapshot Client with NetBackup for DB2

■ Configuration requirements for snapshot backups with NetBackup for DB2

■ Configuring a snapshot policy for NetBackup for DB2

■ Restoring NetBackup for DB2 from a snapshot backup

■ About configuring NetBackup for DB2 block-level incremental backups on
UNIX and Linux

■ About Snapshot Client effects

■ Performing NetBackup for DB2 backups with Snapshot Client methods

■ Performing NetBackup for DB2 restores with Snapshot Client methods

NetBackup for DB2 with Snapshot Client features
To use NetBackup for DB2 with Snapshot Client, NetBackup Snapshot Client and
NetBackup for DB2 must both be licensed and installed.

The following NetBackup Snapshot Client features are available for use with
NetBackup for DB2.
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Table 5-1 Snapshot Client features used with NetBackup for Oracle

DescriptionFeature

A snapshot backup occurs when NetBackup creates a point-in-time
disk image of the database and copies that image to disk. This
process is nearly instantaneous; so user access to the database is
not interrupted during the backup.

Snapshot backup

This feature enables instant recovery of backups from disk. It
combines snapshot technology with the ability to do rapid
disk-based restores. NetBackup creates the image without
interrupting user access to data. Optionally, the image is retained
on disk as well as backed up to storage. Instant recovery enables
block-level restores.

Instant recovery

An off-host backup shifts the burden of backup processing onto
a separate backup agent, such as an alternate client. This reduces
the effect on the client’s computing resources ordinarily caused
by a local backup. The backup agent reads the data from the client
disk and writes it to storage.

On UNIX and Linux, an off-host backup can also be directed to a
NetBackup media server, or third-party copy device.

Off-host backup

On UNIX and Linux, a block-level incremental (BLI) backup uses
the change tracking capabilities of the Veritas File System (VxFS)
Storage Checkpoint feature. In a BLI backup, only the changed
blocks of data are backed up, not the entire file or file system. A
BLI backup saves time, decreases the amount of backup media
that is required, and significantly reduces CPU and network
overhead during backups.

You can perform a BLI backup with or without RMAN.

Block-level
incremental backup

A proxy copy is a special type of backup in which the NetBackup
for DB2 agent manages the control of the data transfer. During
the backup and restore operations, the proxy copy enables the
agent to manage the entire data movement between the disks that
contain the data files and the storage devices that NetBackup
manages.

Backups and restores remain tightly integrated with DB2 and its
catalog, greatly simplifying administration tasks.

Proxy copy

DB2 provides the list of files that require backup or restore to
NetBackup for DB2 with Snapshot Client.

More information is available.

See “NetBackup for DB2 file-based operations” on page 104.

File-based operations
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Table 5-1 Snapshot Client features used with NetBackup for Oracle (continued)

DescriptionFeature

Stream-based operations are the standard NetBackup
implementation of conventional NetBackup for DB2 backup and
restores.

More information is available.

See “NetBackup for DB2 stream-based operations” on page 103.

Stream-based
operations

About NetBackup for DB2 with Snapshot Client
operations

NetBackup users or schedules start database backups or restores by specifying a
template or shell script in the backup selections list of the DB2 policy. The template
or shell script specifies the objects or commands that perform the backup or
restore on the client. You also can use the bpdb2proxy command to initiate a
NetBackup for DB2 with Snapshot Client backup.

The agent checks that the policy it uses for the backup is configured with the
appropriate Snapshot Client attributes. The agent then initiates file-based backups
of the DB2 files and uses the NetBackup Snapshot Client interface to perform the
data movement.

The NetBackup for DB2 agent uses DB2 APIs to put the data files into quiesce/write
suspend mode. NetBackup then creates a snapshot of the files. After the snapshot
is created, NetBackup for DB2 uses the DB2 APIs to take the data files out of
quiesce/write suspend mode. The data files that are backed up are in quiesce/write
suspend mode only for the period of time it takes to create a snapshot of the data.

About the sequence of a NetBackup for DB2 backup operation with
Snapshot Client methods

For a backup operation, the NetBackup for DB2 agent performs the following tasks
in the order shown:

■ Determines the list of files that make up the DB2 database.

■ Suspends write activity to the data files (quiesces the database).

■ Uses the Snapshot Client method to create a snapshot image of the mapped
files.

■ Enables DB2 write activity (unquiesces the database).
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■ Backs up the snapshot image of the data files.

About the sequence of a NetBackup for DB2 restore operation with
Snapshot Client methods

For a restore operation, the NetBackup for DB2 agent performs the following
tasks:

■ Using the DB2 database and a point in time, locates the correct physical backup
images.

■ Disconnects all users from the database (brings the database offline).

■ Restores the images to the original database.

■ Uses DB2 APIs to takes the files out of the quiesced state, which puts the
database in a roll-forward pending state.

■ Reruns the transactions from the log files (performs the roll-forward operation).

■ Enables user connections to the database (brings the database online).

About database objects supported by advanced backup methods
DB2 allows proxy method backups of databases at the node level, so NetBackup
can use file-based Snapshot Client backup methods to back up databases.
NetBackup for DB2 cannot use Snapshot Client methods to back up individual
tablespaces or container files.

Note: Before you can perform a proxy backup, complete a stream based backup.

DB2 performs only conventional backups for transaction log files. You cannot use
Snapshot Client methods for transaction logs backed up with either the user exit
program or the VENDOR method.

File-based and stream-based backups require different configurations. When you
configure NetBackup for DB2 with Snapshot Client backups, be sure to configure
policies that allow both kinds of backups.

See “How Snapshot Client software affects backup types” on page 117.

About multistreaming and DB2 backups
You can use either the -s option on the bpdb2proxy command or the sessions
parameter in the Backup Options screen of the backup wizard to specify the
number of proxy copy backup streams to start. NetBackup for DB2 splits the files
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into a number of groups as specified by either of these parameters, based on file
size. NetBackup for DB2 attempts to create streams of equal size.

About symbolic links and DB2 backups and restores (UNIX and Linux)
NetBackup for DB2 with Snapshot Client fully supports backups and restores of
data files that consist of symbolic links and regular files. Both the symbolic link
and the actual file are backed up and restored. However, if you select Retain
snapshots for instant recovery, the symbolic link must reside on the same file
system as the data file. When you use instant recovery, if the symbolic link resides
on a different file system than the data file it points to, the restore fails.

NetBackup for DB2 stream-based operations
Stream-based operations are the standard NetBackup implementation of
conventional NetBackup for DB2 backup and restores. In a stream-based backup,
NetBackup moves the data that is provided by the server process. NetBackup
captures the data stream content that is provided by DB2. If the user has specified
multiple streams, then NetBackup for DB2 opens multiple streams and NetBackup
catalogs them as separate images.

Figure 5-1 represents a stream-based backup or restore.
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Figure 5-1 NetBackup for DB2 stream-based backup or restore
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NetBackup for DB2 file-based operations
In a file-based operation, DB2 provides the list of files that require backup or
restore to NetBackup for DB2 with Snapshot Client. NetBackup for DB2 with
Snapshot Client performs the data movement.

Figure 5-2 represents a file-based backup or restore.
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Figure 5-2 NetBackup for DB2 with Snapshot Client file-based backup or restore

DB2 Server

NetBackup

Data

List of files

Control commands

Data

DB2 database disk
NetBackup for DB2

DB2 database disk

Example: multiple channels for a DB2 command with proxy method
The following NetBackup for DB2 sample command initiates a database backup
(which includes the transaction logs) on a per node basis:

bpdb2proxy -backup -d sample -u db2user -p password -s 3 -n 0

The agent splits the files into three streams and initiates a file-based backup for
each stream. After the proxy backup is done, DB2 starts a non-proxy conventional
backup of the transaction logs.

Issue this command on each node of the database.

About configuring Snapshot Client with NetBackup
for DB2

This topic explains how to configure snapshot and instant recovery backups for
the DB2 policy. For information on how a snapshot method is automatically
selected and details on the types of backup methods, see theNetBackup Snapshot
Client Administrator’s Guide.
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Snapshot backups do not back up all database objects. Your backup configuration
must include policies to perform file-based and stream-based backups. This
configuration ensures that the entire database can be restored successfully.

For snapshot or instant recovery backups, configure the following policies and
schedules as follows:

■ A DB2 policy with the following attributes:

■ Snapshot methods for the file systems in which the database files reside.

■ A backup method on the policy attributes dialog box.

■ An Automatic Full Backup schedule to perform file-based snapshot and
off-host backups of the database.

■ (Conditional) An Application Backup schedule to back up the transaction
logs. Configure this policy if you use the VENDOR method. DB2 does not
support proxy backups of transaction logs.

■ On UNIX and Linux, a Standard policy to perform stream-based backups of
transaction logs. Configure this policy if you use the user exit program. DB2
does not support proxy backups of database transaction logs.

■ On Windows, an MS-Windows policy to perform stream-based backups of
transaction logs. Configure this policy if you use the user exit program. DB2
does not support proxy backups of database transaction logs.

Configuration requirements for snapshot backups
with NetBackup for DB2

Each agent has its own hardware requirements, software requirements,
compatibility with certain features, and the snapshot methods that are supported.
Special requirements apply for specific types of backups. See the NetBackup
Snapshot Client Administrator’s Guide and the Symantec Support Web site for
more information. Familiarize yourself with this information before you configure
any snapshot backups.

The following list highlights some of the requirements that pertain to database
agents:

■ Snapshot Client backups do not back up all database objects. Your backup
configuration must include policies to perform file-based and stream-based
backups. This configuration ensures that the entire database can be restored
successfully.

■ On UNIX or Linux, the user identification and group identification numbers
(UIDs and GIDs) associated with the files to be backed up must be available to
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both the primary client and the alternate backup client. The UID on the primary
client and the alternate backup client must be the same. Similarly, the GID on
the primary client and the alternate backup client must be the same.

Note: The UID number can be different than the GID number.

■ Allocate up to three different volumes or file systems for database activities,
as follows:

■ Allocate one or more volumes or file systems to the database data files.

■ Allocate a different set of volumes or file systems to the DB2 executables,
configuration files, and the transaction logs.

One reason to have two different volumes is to separate the data files from
the other files. If the logs are configured on the same volumes (or file systems)
as the data files, the logs are temporarily frozen while NetBackup takes the
snapshot. The process cannot access the logs when the database is active, so
the database activity may freeze until the logs become accessible again.
Another reason for writing the data files to their own repository is because it
is required for an instant recovery point-in-time rollback. Only data files can
exist on the volume or the file system that you want to restore.

■ The hardware and software that is required for the appropriate snapshot
method must be installed and configured correctly.

■ NetBackup Snapshot Client must be installed and configured correctly, and
the license key for this option must be registered.

■ To perform off-host backups, perform any special configuration that is
required.

Configuring a snapshot policy for NetBackup for DB2
The following procedure shows how to configure a snapshot policy with optional
instant recovery, snapshot retention, and off-host backup.

To configure a snapshot policy

1 Open the policy you want to configure.

2 Click on the Attributes tab.
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3 Select the DB2 policy type.

Select the policy type

Select appropriate storage unit
or storage unit group

(Optional) Click Perform off-host
backup and specify a method

Click Perform snapshot
backups

(Optional) Click Retain snapshots for
instant recovery

4 Select a policy storage unit from the Policy storage list.

Select a policy storage unit in this step even if you plan to select Snapshots
only later in this procedure.

NetBackup uses this storage unit for the stream-based backups of the control
files and the transaction logs that are included in this policy.

On UNIX and Linux, NetBackup also uses this storage unit if you select Third
Party Copy Device when you configure the schedule.

On UNIX and Linux, Any_available is not supported for the following data
movers: NetBackup Media Server or Third-party Copy Device.

5 Click Perform snapshot backups.
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6 (Optional) Click Options to choose a snapshot method.

By default NetBackup chooses a snapshot method for you. To choose a
snapshot method, click auto (the default) or click one of the methods that are
presented in the list.

The snapshot method that you can use depends on your hardware
environment and software environment. Only certain snapshot methods are
supported in certain environments. See the NetBackup Snapshot Client
Administrator’s Guide or the supported platforms matrix on the Symantec
Support Web site for more information.

You can configure only one snapshot method per policy. For example, assume
that you want one snapshot method for clients a, b, and c, and a different
method for clients d, e, and f. Then you need to create two policies for each
group of clients and select one method for each policy.

7 (Optional) Select RetainsnapshotsforInstantRecoveryorSLPmanagement.

When this option is selected, NetBackup retains the snapshot backup image
on disk for later use in recovery.

8 (Optional) Select Perform off-host backup.

By default, the client that hosts the database performs the backup. If you
want to reduce the I/O processing load on the client that hosts the database,
specify an alternate client to perform the backup.

9 (Conditional) Select an off-host backup method.

The following off-host backup methods are available:

If you select Alternateclient, also specify the name of the client
to perform the backup. This option may require additional
configuration. The alternate client must be a client that shares
the disk array.

Use Alternate
client (UNIX and
Windows clients)

If you click Datamover, also select one of the following possible
data movers:

■ NetBackup Media Server
■ Third-Party Copy Device

Use Data mover
(UNIX clients
only).

10 Click the Schedules tab.

11 Click New.

12 Configure an Automatic schedule for the database files.
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13 (Conditional) In the Schedules dialog box, in the Instant Recovery group,
select Snapshots only.

This setting suppresses NetBackup’s default behavior, which is to copy the
snapshot to a storage unit. When you select Snapshots only, NetBackup
creates the on-disk snapshot copy of the database, but it does not copy the
snapshot to a storage unit. The on-disk snapshot becomes the only backup
copy. Note that the on-disk snapshot is not considered to be a replacement
for a traditional backup.

14 (Conditional) Configure an Application Backup for the control files and
transaction logs.

NetBackup uses this storage unit for the stream-based backups of the control
files and the logs that are included in this policy. Configure this schedule only
if you want to use the VENDOR method for backing up the transaction logs.
NetBackup copies the database’s control files and transaction logs to the
storage unit you selected.

For UNIX clients, if you select Third-PartyCopyDevice as an off-host backup
method, select Override policy storage unit. Then select a non-SAN Media
Manager or other storage unit type that is appropriate to back up the control
files and transaction logs.

15 On the Clients tab, specify the clients to be included in this policy.

16 On the Backup Selections tab, specify a template script or backup script.

More information is available about how to use templates and scripts for a
NetBackup for DB2 policy with Snapshot Client.

See “How Snapshot Client software affects templates and scripts” on page 119.

17 Configure other attributes and add any additional schedules and backup
selections.

RestoringNetBackup forDB2 fromasnapshot backup
The following topics describe how to restore files, volumes, and file systems from
a snapshot backup:

■ See “About restoring individual files from a NetBackup for DB2 snapshot
backup” on page 111.

■ See “About NetBackup for DB2 restores of volumes and file systems using
snapshot rollback” on page 111.

■ See “Performing a NetBackup for DB2 point-in-time rollback restore from a
SnapVault backup (UNIX and Linux)” on page 112.
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■ See “Performing a snapshot rollback restore from the Java or Windows
interface” on page 112.

About restoring individual files from a NetBackup for DB2 snapshot
backup

Data that is backed up with Snapshot Client methods is restored in the same way
as data that is backed up without Snapshot Client methods.

See “Performing a database restore” on page 82.

Use this procedure for the files that were backed up with, or without, instant
recovery enabled. In all cases, NetBackup determines the files that were backed
up, and it initiates a corresponding restore request to the database agent.

If instant recovery is enabled, NetBackup attempts to restore the file by using the
unique restore methods available with the instant recovery feature. The type of
restore method that NetBackup uses depends on your environment and the type
of backup performed. If NetBackup is unable to use any of the instant recovery
methods, it restores the file in the typical manner. Data is copied from the snapshot
to the primary file system. Information on the instant recovery methods that
NetBackup uses is available.

See the NetBackup Snapshot Client Administrator’s Guide.

About NetBackup for DB2 restores of volumes and file systems using
snapshot rollback

You can request that an entire volume or an entire file system be restored from
an instant recovery Snapshot backup. This type of a restore is called a point in
time rollback. All the data in the snapshot is restored; single file restore is not
available in a rollback.

You can perform a snapshot rollback from an instant recovery backup that was
made with the following methods:

■ UNIX and Linux: VxFS_Checkpoint snapshot

■ vxvm snapshot

■ FlashSnap snapshots

See the NetBackup Snapshot Client Administrator’s Guide.

The following considerations are relevant for NetBackup for DB2 restores:

■ Snapshot rollback overwrites the entire volume.
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■ With NetBackup for DB2, snapshot rollback always performs file verification.
The agent checks for the following:

■ The requested files (number and names) are identical to those in the
snapshot

■ The primary volume does not contain any files that were created after the
snapshot was made

If verification fails, the rollback aborts with 249.

■ Use snapshot rollback with database files only. Database files and archive logs
should exist on different file systems or volumes.

Performing a NetBackup for DB2 point-in-time rollback restore from
a SnapVault backup (UNIX and Linux)

When you select a point-in-time rollback restore from a SnapVault backup,
NetBackup restores the entire subvolume (qtree) to a new subvolume (qtree) on
the primary host. The restore does not overwrite the existing subvolume. File
verification is not performed.

The format of the new subvolume name is as follows:

mountpointname_restore.timestamp

For example: subvol1_restore.2005.05.19.10h49m04s

To perform a NetBackup for DB2 point-in-time rollback restore from a SnapVault
backup (UNIX and Linux)

1 Unmount the original subvolume, which is the subvolume that the restore
process did not overwrite.

2 Rename the original subvolume.

3 Rename the new subvolume with the name of the original.

4 Mount the new subvolume on the client. Use the ALTER DATABASE RENAME

DATAFILE command to point to the restored data file on the newly created
subvolume.

Performing a snapshot rollback restore from the Java or Windows
interface

This topic describes how to perform a snapshot rollback restore from the Java or
Windows interface.
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To perform a snapshot rollback restore from the Java or Windows interface

1 If the file .SQLCRT.FLG exists, delete it.

DB2 creates the .SQLCRT.FLG file when it creates a directory (usually during
tablespace creation). For volume level rollback restores this file cannot be
present. The directory structure must be present at the time DB2 creates a
tablespace or you must delete this file after DB2 creates the directory during
tablespace creation.

2 Open the Backup, Archive, and Restore interface.

3 Select one of the following:

■ In the Java interface, click the Restore Files tab.

■ In the Windows interface, select File>SelectFilesandFolderstoRestore.

4 Select Actions > Select Restore Type > Point in Time Rollback.

5 Use the NetBackup for DB2 recovery wizard for the restore.

See “Performing a database restore” on page 82.

About configuring NetBackup for DB2 block-level
incremental backups on UNIX and Linux

If only a small portion of a database changes on a daily basis, full database backups
are costly in terms of time and media. The block-level incremental (BLI) backup
interface extends the capabilities of NetBackup to back up only changed data
blocks.

A database BLI backup is done at the file system block level, which means only
changed blocks are backed up. Changed files are not backed up. VxFS Storage
Checkpoint facility identifies changed blocks in real time. BLI backup does not
need to search the entire database for the modified blocks. BLI backup saves time,
decreases the amount of backup media that is required, and significantly reduces
CPU and network overhead during backups. In addition, BLI backup allows more
frequent backups, so backup images are more up to date.

BLI backup is particularly useful for any large databases that are sized in terms
of hundreds of gigabytes or terabytes. Most traditional methods for database
backup require that any change in the database—no matter how small—requires
that the entire database is backed up. With BLI backup, only modified data blocks
need to be backed up.

The recommended method for performing BLI backups is the proxy BLI agent
with NetBackup for DB2. This method supports the other features of NetBackup
for DB2, including the policy types and schedules and the convenience of the
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template generation wizard. It also remains tightly integrated with NetBackup
for DB2 and its catalog, which greatly simplifies administration tasks.

How BLI works with NetBackup for DB2 (UNIX and Linux)
NetBackup supports BLI full backups and BLI incremental backups of DB2
databases.

BLI backup supports two types incremental backups: differential and cumulative.
Full, differential incremental, and cumulative incremental backups are specified
as part of the backup schedule. When performing a restore, NetBackup restores
an appropriate full backup. Then it applies the changed blocks from the
incremental backups.

Restoring any of the incremental backup images requires NetBackup to restore
the last full backup image and all the subsequent incremental backups until the
specified incremental backup image is restored. NetBackup performs this restore
process automatically, and it is completely transparent. The media that stored
the last full backup and the subsequent incremental backups must be available,
or the restore cannot proceed.

Note that restoring a file rewrites all blocks in that file. The first subsequent
differential incremental backup and all subsequent cumulative incremental
backups back up all the blocks in the restored file. After restoring an entire
database, the first subsequent backup results in a full backup.

The restore destination can be a VxFS, UFS (Solaris), JFS (AIX), or HFS (HP-UX)
file system. The destination VxFS file system does not need to support the Storage
Checkpoint feature to restore files, but a VxFS file system with the Storage
Checkpoint feature is needed to perform BLI backups of the restored data.

This topic uses the following terms to describe BLI backups:

■ Full Backup.
A backup in which NetBackup backs up the entire database file, not just data
blocks changed since the last full or incremental backup.

■ Cumulative BLI Backup.
This is a backup of all the data blocks of database files that changed since the
last full backup. A cumulative BLI backup image contains only the data blocks
of database files that changed since the last full backup, but a cumulative BLI
backup can reduce the number of incremental backup images that must be
applied to a restore operation. This speeds up the restore process.

■ Differential BLI backup.
This is a backup in which NetBackup performs a backup of only those data
blocks of database files that changed since the last backup of any type (full,
cumulative incremental, or differential incremental backup) was performed.

Using Snapshot Client with NetBackup for DB2
About configuring NetBackup for DB2 block-level incremental backups on UNIX and Linux

114



When NetBackup initiates full database backups, followed by BLI backups, it
creates, manages, and uses the appropriate Storage Checkpoints of the DB2
container file systems. These Storage Checkpoints identify and maintain a list of
modified blocks.

About the Storage Checkpoint facility and NetBackup for DB2
The BLI backup methodology uses the Storage Checkpoint facility in the Veritas
File System (VxFS). This facility is available through the Storage Foundation for
DB2.

The VxFS Storage Checkpoint facility keeps track of data blocks modified by the
database since the last backup. NetBackup with BLI backup leverages this facility
to back up only changed blocks, not the entire database, for an incremental backup.

VxFS Storage Checkpoint is a disk-efficient and I/O-efficient snapshot of file
systems. A Storage Checkpoint provides a consistent, stable view of a file system
at the instant when the file system was snapped or checkpointed. Instead of making
a physically separate copy of the file system, a Storage Checkpoint identifies and
maintains only changed file system blocks, saving disk space and significantly
reducing I/O overhead.

By keeping track of changed blocks, the VxFS Storage Checkpoint enables BLI
backups. VxFS Storage Checkpoint facility provides a consistent view of file
systems, which allows BLI backup to freeze the database image during database
backups.

The Storage Checkpoint operation is similar to the snapshot file system
mechanism. However, unlike a snapshot, the Storage Checkpoint persists after a
system reboot. Also, the Storage Checkpoint operation is totally transparent to
administrators. The Checkpoint image is managed and available only through
NetBackup or through the VxDBA utility for database backup available with the
Veritas Storage Foundation.

For more information on Storage Checkpoints, see theVeritas StorageFoundation
documentation.

You can take a Storage Checkpoint while the database is online or offline. To take
a Storage Checkpoint while the database is online, you must enable archive log
mode. During the creation of the Storage Checkpoint, all tablespaces are placed
in backup mode.

Configuration requirements for BLI backups with NetBackup for DB2
Before you configure BLI backups, make sure your configuration meets the
following requirements:
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■ NetBackup for DB2 is installed, licensed, and configured.

■ NetBackup Snapshot Client is installed and configured, and the license key for
this option is registered.

■ Veritas Storage Foundation for DB2 must be installed and configured.

■ Veritas File System must have Storage Checkpoint licensed.

For more information on requirements, see the NetBackup Snapshot Client
Administrator’s Guide.

Configuring policies for BLI backups with NetBackup for DB2
This topic explains how to configure BLI backups for DB2 policies. BLI backups
do not back up the transaction logs. Include policies to perform file-based and
stream-based backups.

Your backup configuration must ensure that the entire database can be successfully
restored.

To configure a policy for BLI backups, configure the following:

■ The BLI backup method on the policy attributes dialog box.

■ An Automatic Backup schedule to perform full and incremental file-based
backups of the data files.

■ (Conditional) An Application Backup schedule to perform a stream-based
backup of transaction logs. Specify this schedule if you use the VENDORmethod
for backing up the transaction logs. These files are backed up with the standard
NetBackup for DB2 operations.

■ (Conditional) A User Backup schedule to perform a stream-based backup of
transaction logs. Specify this schedule if you use the user exit program to back
up the transaction logs.

To configure a policy for BLI backups

1 Open the policy you want to configure.

2 Click the Attributes tab.

3 From the Policy Type list, choose DB2.

4 Select a Policy storage.

5 Select Perform block level incremental backups.

6 To configure schedules, click the Schedules tab.

DB2 does not support proxy backups of database control files and archive
logs.
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To perform a whole database proxy backup, configure the following:

■ One or more automatic backup schedules to perform proxy BLI backups
of the database.
This backup automatically includes a backup of the control file.

■ An Application Backup schedule type to back up the control files and
archive logs.

7 On the Clients tab, specify clients to be backed up with this policy.

8 On the Backup Selections tab, specify the template or script.

About the types of NetBackup for DB2 BLI backups
NetBackup performs proxy BLI backups with Automatic Full Backup, Automatic
Differential Incremental Backup, and Automatic Cumulative Incremental Backup
schedules.

NetBackup for DB2 checks that a full backup was performed before it proceeds
with an incremental backup. If the NetBackup scheduler or user initiates an
incremental backup, and NetBackup for DB2 finds no record of a full backup using
the same policy, it performs a full backup.

To ensure that it has a proper set of images to restore, NetBackup performs a full
backup when it encounters the following situations:

■ If the number of backup streams that is specified changed from the previous
backup. This change can be made through the GUI or through a DB2 command.

■ If NetBackup does not have a valid full backup image for the same policy in
its database. For example, this situation can occur if images were expired.

NetBackup for DB2 always initiates a full backup under these conditions, even if
you want to perform an incremental backup.

About Snapshot Client effects
The following topics describe how the Snapshot Client software affects backup
types, schedule properties, and templates. Snapshot Client also affects scripts.

How Snapshot Client software affects backup types
The backup types available on the Schedules tab of the policy play a different role
for NetBackup for DB2 with Snapshot Client backups.

See Table 5-2 on page 118.
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Table 5-2 Backup types for DB2 policies

DescriptionBackup type

The Application Backup schedule enables stream-based NetBackup
operations. The Default-Application-Backup schedule is
automatically configured as an Application Backup schedule.

On UNIX and Linux clients, if you want to use Third-party Copy
as your off-host backup method, override the policy storage unit.
Specify a non-SAN media manager or other storage unit type for
the Application Backup schedule.

Application Backup

For file-based proxy copy backups, the automatic backup schedule
types automatically start the backups by running the NetBackup
for DB2 scripts or templates.

If you specify any of the automatic backup types, a full backup is
performed.

Automatic Full Backup

Automatic Differential
Incremental Backup,

Automatic Cumulative
Incremental Backup

How Snapshot Client software affects schedule properties
Some schedule properties have a different meaning for Snapshot Client database
backups than for a regular database backup. For a description of other schedule
properties, see the information that is specific to standard database agent backups.

See “About NetBackup for DB2 schedule properties” on page 41.

Table 5-3 explains the properties for Snapshot Client backups.

Table 5-3 Schedule properties

DescriptionProperty

Frequency based scheduling

For proxy backups, NetBackup uses the retention period for the
automatic type of backup to specify how long to keep proxy
file-based backup images.

Calendar based scheduling

For proxy backups, NetBackup for DB2 with Snapshot Client uses
the retention period for the automatic type of backup to specify
how long to keep proxy file-based backup images.

Retention

For proxy file-based backups, configure Multiple copies on the
automatic backup schedule.

Multiple copies
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How Snapshot Client software affects templates and scripts
You can use a template that was created by the backup wizard to perform backups
with Snapshot Client. After they are created, templates reside on the NetBackup
master server and are available for use by other NetBackup for DB2 clients.

See “About NetBackup for DB2 templates and shell scripts” on page 61.

Whether you use a template or script, you must enable the advanced backup
method for your clients. Configure this method on the Attributes tab of the policy.
At run time, the template checks the policy attributes to determine if a Snapshot
Client backup method is configured. Then it initiates the proxy file-based backup.

If you use a script, the script must reside on each client that is included in the
policy. Include the DB2bpdb2proxy command in the script to perform the advanced
backup method. Sample scripts are included with the installation.

Performing NetBackup for DB2 backups with
Snapshot Client methods

After configuration is complete, performing NetBackup for DB2 with Snapshot
Client backups and restores is similar to regular NetBackup for DB2 operations.
The following sections describe some of the differences.

NetBackup for DB2 performs backups with Snapshot Client in the following ways:

■ User-directed, by template creation and execution on the client

■ User-directed, from the command line as a DB2 user (with the bpdb2proxy

command)

■ Server-directed, both automatic and scheduled from the master server

All of these methods require a DB2 policy with Snapshot Client configuration.
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To perform a backup from the Backup, Archive, and Restore
interface, run a template through DB2 Template
Administration (click Actions > Administer Templates >
DB2). You can also create a new template using the DB2
Backup Wizard, and run the template from the Template
Complete screen.

The backup that results from the template is an Snapshot
Client backup if the policy for the client is configured for
Snapshot Client methods. Specify the policy by adding the
client to that policy on the master server.

On UNIX and Linux, you can also specify the policy in the
db2.conf file on the client.

User-directed backups using
templates

Use the bpdb2proxy command to perform a Snapshot
Client backup of your DB2 database from the command line.
You must be the DB2 user to use thebpdb2proxy command.
For backups, specify the-backupoption withbpdb2proxy.

Use the bpdb2proxy command in the following format to
back up a DB2 database with a Snapshot Client method:

UNIX and Linux: /bin/bpdb2proxy -backup -d

dbalias -u user -p password

Windows:install_path\NetBackup\bpdb2proxy
-backup -d dbalias -u user -p password

User-directed backups using
bpdb2proxy

The following describes the process for configuring policies
for DB2 backups with Snapshot Client.

See “Configuring a snapshot policy for NetBackup for DB2”
on page 107.

These policies specify Snapshot Client backups for the DB2
database.

Server-directed backups

Performing NetBackup for DB2 restores with
Snapshot Client methods

Perform NetBackup for DB2 Snapshot Client restores from the DB2 client. The
following describes two methods of user-directed restores and restoring from a
snapshot backup:
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Use the NetBackup for DB2 Recovery Wizard to select the
files you want to restore and the parameters for the restore.
If the backup image was created with Snapshot Client
methods, the restore uses Snapshot Client methods.

Restore using the Backup,
Archive, and Restore
interface (user-directed)

Use the bpdb2proxy command. You must be the DB2 user
to use the bpdb2proxy command. For restores, specify the
-restore option with bpdb2proxy.

Note: The backup image you restore with bpdb2proxy

must be from a Snapshot Client method backup, otherwise,
the restore fails.

Use the bpdb2proxy command in the following format to
restore a DB2 database with a Snapshot Client method:

UNIX and Linux: /bin/bpdb2proxy -restore -d

dbalias -u user -p password

Windows: install_path\NetBackup\bpdb2proxy
-restore -d dbalias -u user -p password

Restore using the command
line (user-directed)

See “About NetBackup for DB2 restores of volumes and file
systems using snapshot rollback” on page 111.

Restore from a snapshot
backup
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Troubleshooting NetBackup
for DB2

This chapter includes the following topics:

■ NetBackup debug logs and reports

■ Enabling the debug logs for a NetBackup for DB2 client automatically (Windows)

■ Enabling the debug logs for NetBackup for DB2 manually (Windows)

■ Enabling the debug logs for a NetBackup for DB2 for UNIX or Linux client

■ About the NetBackup for DB2 log files

■ Setting the debug level on a NetBackup for DB2 Windows client

■ Setting the debug level on a UNIX or Linux client

■ About NetBackup server reports

■ Minimizing timeout failures on large database restores

■ Minimizing loading and unloading of tapes for database backups (UNIX and
Linux)

■ Using NET_BUFFER_SZ to speed up a slow restore

■ About false restore failures reported in the activity monitor

■ About the error message codes
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NetBackup debug logs and reports
The NetBackup server and client software let you enable detailed debugging logs.
The information in these log files can help you troubleshoot the problems that
occur outside of either the database agent or the DB2 commands.

Note the following with regard to these logs:

■ These logs do not reveal the errors that occur when DB2 commands are running
unless those errors also affect NetBackup. DB2 may (or may not) write errors
in the application to the NetBackup logs. Your best sources for DB2 error
information are the logs provided by DB2.

■ Generally, each debug log corresponds to a NetBackup process and executable.

Information about the debugging log files is available.

See the NetBackup Troubleshooting Guide.

Also refer to the following file:

Windows: install_path\NetBackup\logs\README.debug file

UNIX and Linux: /usr/openv/netbackup/logs/README.debug file

Enabling the debug logs for a NetBackup for DB2
client automatically (Windows)

You can enable debug logging by running a batch file that creates each log
directory. To create all log file directories automatically, run the following:

install_path\NetBackup\logs\mklogdir.bat

Or, you can manually create the directories for the log files you want created.

See “Enabling the debug logs for NetBackup for DB2 manually (Windows)”
on page 125.
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Enabling the debug logs for NetBackup for DB2
manually (Windows)

Creating the NetBackup for DB2 for Windows database agent logs manually

1 Create the following directories on the client in a DOS window:

install_path\NetBackup\logs\bpbackup

install_path\NetBackup\logs\bpbkar32

install_path\NetBackup\logs\bpdbsbdb2

install_path\NetBackup\logs\bphdb

install_path\NetBackup\logs\bprestore

install_path\NetBackup\logs\bpubsdb2

install_path\NetBackup\logs\dbclient

install_path\NetBackup\logs\tar32

install_path\NetBackup\logs\bpdb2

For example:

cd install_path\NetBackup\logs

mkdir bphdb

2 Make sure there is share access to the log directories.

3 Enable logging for the nbpem, nbjm, and nbrb scheduling processes, which
use unified logging.

NetBackup writes unified logs to install_path\NetBackup\logs.

You do not need to create log directories for processes that use unified logging.
For information on how to use logs and reports, see the NetBackup
Troubleshooting Guide.
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Enabling the debug logs for a NetBackup for DB2 for
UNIX or Linux client

Enabling the NetBackup for DB2 logs manually (UNIX/Linux)

1 Create the following directories on the client:

/usr/openv/netbackup/logs/bpbackup

/usr/openv/netbackup/logs/bpbkar

/usr/openv/netbackup/logs/bpdb2

/usr/openv/netbackup/logs/bpdbsdb2

/usr/openv/netbackup/logs/bphdb

/usr/openv/netbackup/logs/bprestore

/usr/openv/netbackup/logs/bpubsdb2

/usr/openv/netbackup/logs/dbclient

/usr/openv/netbackup/logs/tar

/usr/openv/netbackup/logs/bpdb2

chmod 777 /usr/openv/netbackup/logs/bpdb2

For example:

cd /usr/openv/netbackup/logs

mkdir bphdb

2 The user_ops, each of the log directories, and any subdirectories should have
777 permissions. They must exist and be accessible for the applications to
operate correctly.

For example:

chmod 777 bphdb

See “About permissions for NetBackup for DB2 log files (UNIX and Linux)”
on page 30.
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3 Enable logging for the nbpem, nbjm, and nbrb scheduling processes that use
unified logging.

NetBackup writes unified logs to /usr/openv/logs.

You do not need to create log directories for processes that use unified logging.

Information on how to use logs and reports is available.

See the NetBackup Troubleshooting Guide.

About the NetBackup for DB2 log files
The following topics describe the logs that are created when you create the log
directories. Use a text editor to view the contents of the logs.

See “About the bphdb directory on the Windows database client” on page 127.

See “About the bphdb directory on the UNIX or Linux database client ” on page 127.

About the bphdb directory on the Windows database client
The install_path\NetBackup\logs\bphdb directory contains log files.

The following types of logs exist:

■ db2_stdout.mmddyy.hhmmss.txt

Unless it is redirected elsewhere, NetBackup writes DB2 script output to this
file.

■ db2_stderr.mmddyy.hhmmss.txt

Unless it is redirected elsewhere, NetBackup writes DB2 script errors to this
file.

■ mmddyy.log

This log contains debugging information for the bphdb process. bphdb is the
NetBackup database backup binary. It is invoked when an automatic backup
schedule is run. NetBackup for DB2 uses this client process for DB2 script
execution.

About the bphdb directory on the UNIX or Linux database client
The /usr/openv/netbackup/logs/bphdb directory contains logs.

The following types of logs exist:

■ db2_stdout.mmddyy
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Unless it is redirected elsewhere, NetBackup writes DB2 script output to this
file.

■ db2_stderr.mmddyy

Unless it is redirected elsewhere, NetBackup writes DB2 script errors to this
file.

■ log.mmddyy

This log contains debugging information for the bphdb process. bphdb is the
NetBackup database backup binary. It is invoked when an automatic backup
schedule is run. NetBackup for DB2 uses this client process for DB2 script
execution.

About the bpdb2 directory on the UNIX or Linux database client
The /usr/openv/netbackup/logs/bpdb2 directory contains execution logs.

The following execution log exists:

■ log.mmddyy

This log contains debugging information and execution status for the
NetBackup for DB2 client process.

About the bpdbsbdb2 directory on the client
On UNIX and Linux, the /usr/openv/netbackup/logs/bpdbsbdb2 directory
contains the following execution log:

log.mmddyy

On Windows, the install_path\NetBackup\logs\bpdbsbdb2 directory contains
the following execution log:

mmddyy.log

This log contains debugging information and execution status for the NetBackup
for DB2 backup and recovery wizards and for the bpdbsbdb2 command line utility.
This log also contains the debugging information and execution status information
that is generated when a DB2 template is run from an automatic schedule (when
bphdb invokes bpdbsbdb2 to run the template).
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Setting the debug level on a NetBackup for DB2
Windows client

To control the amount of information that is written to the debug logs, change
the Database debug level. Typically, the default value of 0 is sufficient. However,
technical support may ask you to set the value higher to analyze a problem.

The debug logs are located in install_path\NetBackup\logs.

Note: Information from both the Verbose and the Database debug settings is logged
to the same file, mmddyy.log

To set the debug level on a NetBackup for DB2 for Windows client

1 From the Windows Start menu, choose Programs > Symantec NetBackup >
Backup, Archive, and Restore.

2 Select File > NetBackup Client Properties.

3 Click the Troubleshooting tab.

4 Set the Verbose debug level.

Set this level to adjust the amount of information from the user exit program.

5 Set the Database debug level.

Set this level to adjust the amount of information from the NBDB2 vendor
library.

6 Click OK to save your changes.

Setting the debug level on a UNIX or Linux client
To control the amount of information that is written to the debug logs, change
the “Database” debug level. Typically, the default value of 0 is sufficient. However,
Technical Support may ask you to set the value higher to analyze a problem.

The debug logs are located in /user/openv/netbackup/logs.

To set the debug level on a UNIX or Linux client

◆ Enter the following line in the bp.conf file.

VERBOSE = X

Where X is the debug level you want.
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About NetBackup server reports
NetBackup provides other reports that are useful in isolating problems. One such
report is All Logs Entries on the server. Information on server reports is available.

See the NetBackup Administrator’s Guide.

Minimizing timeout failures on large database
restores

Large database restores sometimes fail when multiple restore sessions compete
for resources. In this situation, a restore session can be delayed while waiting for
media or device access. If the delay is too long, the restore session times out. Use
the following procedure to minimize session timeouts and to allow the restores
to complete successfully.

To minimize timeout failures on large database restores

1 In the NetBackup Administration Console, expand NetBackupManagement
> Host Properties > Clients

2 Set the Client read timeout property to a large value.

The default for the Client read timeout setting is 300 seconds (5 minutes).
For database agent clients, increase the value significantly from the
recommended value.

See the NetBackup Administrator’s Guide, Volume 1.

For example, change this setting to 30-60 minutes to minimize timeout errors.

3 Click OK for each client.

Minimizing loading and unloading of tapes for
database backups (UNIX and Linux)

You can minimize excessive unloading and reloading of tapes between
multistreamed database backups by making changes on the NetBackup media
server.

To minimize loading and unloading of tapes

◆ In the /usr/openv/netbackup/bp.conf file on the NetBackup media server,
add the following options:

■ MEDIA_UNMOUNT_DELAY.
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■ MEDIA_REQUEST_DELAY. Use this variable only with non-robotic drives,
such as tape stackers.

Using NET_BUFFER_SZ to speed up a slow restore
If file restores are slow and your NetBackup master server is a UNIX machine,
you can increase file restore speeds. Create a file called NET_BUFFER_SZ on the
NetBackup master server in the NetBackup install directory.

To create the NET_BUFFER_SZ file

1 Log into a UNIX master server.

2 Use vi(1) or another editor to create file
/usr/openv/netbackup/NET_BUFFER_SZ.

3 Add a line that specifies the socket size, in bytes.

For example:

32768 bytes = 32K

4 Save and close the file.

About false restore failures reported in the activity
monitor

In some restore scenarios, DB2 reports a successful restore status, but the
NetBackup activity monitor reports failures. This can occur during restores if
DB2 reads a portion of a backup image but not the entire image.

About the error message codes
The following table describes the DB2 and NetBackup reason codes. For more
information about an error message, see the log files.

Errors can occur while accessing the NetBackup shared library (UNIX and Linux)
or DLL (Windows) during the processing of a DB2 database utility BACKUP or
RESTORE.
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Table 6-1 DB2 and NetBackup error codes

DescriptionError code

Message: ERR - No match for a database image file was found based on
the following criteria.

Cause: The restore criteria of database name, instance, type, and backup
time object cannot be found in the NetBackup database.

Action: Use bplist to make sure the image you want to restore exists.
Make sure the correct instance is used.

Make sure the correct values are set in db2.conf. Also, on UNIX and
Linux check the values in bp.conf.

If logging is enabled, check the current log file in the following directory
for more information:

UNIX and Linux: /usr/openv/netbackup/logs/bpdb2

Windows: install_path\NetBackup\logs\bpdb2\

300

Message: ERR - found more than one object.

Cause: Multiple DB2 backup images were found in the NetBackup
database that matched the restore criteria of database name, instance,
type, and backup time.

Action: This error should not occur under typical operations. If logging
is enabled, check the current log file in the following directory for more
information:

UNIX and Linux: /usr/openv/netbackup/logs/bpdb2

Windows: install_path\NetBackup\logs\bpdb2\

305

Message: ERR - bp.config failed with status status.

Cause: UNIX and Linux: Unable to read configuration file
/usr/openv/netbackup/bp.conf.

Windows: Unable to read configuration file.

Action: Make sure the file exists and is properly configured.

If logging is enabled, check the current log file in the following directory
for more information:

UNIX and Linux: /usr/openv/netbackup/logs/bpdb2

Windows: install_path\NetBackup\logs\bpdb2\

310
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Table 6-1 DB2 and NetBackup error codes (continued)

DescriptionError code

Message: ERR - Invalid options encountered for action action.

Cause: Invalid option(s) encountered for action.

Action: Make sure the action parameters are used properly.

330

Message: ERR - in get DB2 UDB level.

Cause: NetBackup server and the NetBackup for DB2 shared library
(UNIX and Linux) DB2 DLL (Windows) or are not at the same level.

Action: Make sure that the NetBackup and the NetBackup for DB2 shared
library (UNIX and Linux) or the DB2 DLL (Windows) are at the same
level. Check the log file in the following directory:

UNIX and Linux: /usr/openv/netbackup/logs/bpdb2

Check the version number of the shared library and the version number
for NetBackup. If they are not the same, install the same level.

Windows: install_path\NetBackup\logs\

335

Message: ERR - db2.conf read status error error.

Cause: db2.conf read status error.

Action: Make sure the directory is accessible with read and write
permissions. Make sure the file exists and has read permission.

380

Message: ERR - Found multiple <DATABASE> entries before an
<ENDOPER> entry was encountered.

Cause: Found multiple DATABASE entries before an ENDOPER entry was
encountered in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Remove the extra DATABASE entry.

385

Message: ERR - Found multiple <OBJECTTYPE> entries before an
ENDOPER entry was encountered.

Cause: Found multiple OBJECTTYPE entries before an ENDOPER entry
was encountered in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Remove the extra OBJECTTYPE entry.

390
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Table 6-1 DB2 and NetBackup error codes (continued)

DescriptionError code

Message: ERR - Found multiple <POLICY> entries before an <ENDOPER>
entries was encountered.

Cause: Found multiple POLICY entries before an ENDOPER entry was
encountered in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Remove the extra POLICY entry.

395

Message: ERR - Found multiple <SCHEDULE> entries before an
<ENDOPER> entries was encountered.

Cause: Found multiple SCHEDULE entries before an ENDOPER entry was
encountered in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Remove the extra SCHEDULE entry.

400

Message: ERR - Found multiple <ARCFUNC> entries before an
<ENDOPER> entries was encountered.

Cause: Found multiple ARCFUNC entries before an ENDOPER entry was
encountered in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Remove the extra ARCFUNC entry.

405

Message: ERR - Found multiple <ARCDIR> entries before an <ENDOPER>
entries was encountered.

Cause: Found multiple ARCDIR entries before an ENDOPER entry was
encountered in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Remove the extra ARCDIR entry.

410
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Table 6-1 DB2 and NetBackup error codes (continued)

DescriptionError code

Message: ERR - Found multiple <RETDIR> entries before an <ENDOPER>
entries was encountered.

Cause: Found multiple RETDIR entries before an ENDOPER entry was
encountered in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Remove the extra RETDIR entry.

415

Message: ERR - need to specify a valid POLICY or SCHEDULE in db2.conf
for <DATABASE database> and <OBJECTTYPE objecttype>.

Cause: Policy name or schedule name is not specified in the POLICY or
SCHEDULE entry in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Add an appropriate policy name or schedule name to thePOLICY
or SCHEDULE entry.

420

Message: ERR - need to specify a valid ARCDIR in db2.conf: Errno
=error_no : string.

Cause: Invalid ARCDIR is specified in db2.conf.

Action: Add an appropriate directory name to the ARCDIR entry.

425

Message: ERR - ARCDIR field needs to be specified in the db2.conf file.

Cause: No ARCDIR entry found in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Add an ARCDIR field with an appropriate directory name to the
following file:

430
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Table 6-1 DB2 and NetBackup error codes (continued)

DescriptionError code

Message: ERR - RETDIR field needs to contain a valid file when
OBJECTTYPE is equal to ARCHIVE: string.

Cause: RETDIR field does not contain a valid file.

Action: RETDIR field must contain a valid file when OBJECTTYPE

ARCHIVE is specified in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

435

Message: ERR - COPY or SAVE needs to be specified for ARCFUNC when
OBJECTTYPE is equal to ARCHIVE.

Cause: FoundOBJECTTYPE ARCHIVEbut noARCFUNC in thedb2.conf
file.

Action: Specify a copy or save parameter for ARCFUNC if OBJECTTYPE
ARCHIVE is also specified.

440

Message: ERR - Invalid <OBJECTTYPE> entries: entry.

Cause: Invalid OBJECTTYPE entry in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Add the appropriate object type.

445

Message: ERR - OBJECTTYPE entry needs to be specified.

Cause: OBJECTTYPE entry is not specified in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Add the appropriate object type.

450

Message: ERR - POLICY entry needs to be specified.

Cause: POLICY entry is not specified in the following file:

UNIX and Linux: $HOME/db2.conf

Windows: install_path\NetBackup\dbext\db2.conf

Action: Add the appropriate policy name.

455

Message: NetBackup DB2 Handle Invalid

Cause: Internal communication between DB2 and NetBackup failed.

502
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Table 6-1 DB2 and NetBackup error codes (continued)

DescriptionError code

Message: The input parameters supplied by DB2 are not valid.

Cause: This error can occur when you use an unsupported version of
DB2.

505

Message: NetBackup Initialize Failed

Cause: NetBackup encountered errors in preparing for the requested
operation. This can result from improper configuration.

507

Message: NetBackup Read Config Failed

Cause: NetBackup encountered errors in reading configuration settings.

Action: Check that the NetBackup client and server settings are
configured. Also verify that the db2.conf file exists and that it is
configured.

510

Message: NetBackup Write Config Failed

Cause: NetBackup encountered errors in preparing for the requested
operation. This error can result from improper configuration.

511

Message: NetBackup Begin Action Failed

Cause: NetBackup encountered errors when attempting to start the
requested operation. This error can indicate a problem in obtaining
necessary resources.

513

Message: NetBackup Create Image Failed

Cause: NetBackup encountered errors when attempting to create a
backup image.

514

Message: NetBackup Get Image Failed

Cause: NetBackup encountered errors when attempting to access a
backup image.

515

Message: NetBackup Find Image Failed

Cause: NetBackup encountered errors when attempting to locate a
backup image.

516

Message: NetBackup Write Failed

Cause: NetBackup encountered errors when writing a backup image.

518

Message: NetBackup Read Failed

Cause: NetBackup encountered errors when reading a backup image.

520
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Table 6-1 DB2 and NetBackup error codes (continued)

DescriptionError code

Message: NetBackup Commit Data Failed

Cause: NetBackup encountered errors when attempting to close the
backup image.

523

Message: NetBackup Commit Action Failed

Cause: NetBackup encountered errors when attempting to complete the
requested operation.

524

Message: NetBackup Abort Action Failed

Cause: NetBackup encountered errors when attempting to abort the
previously requested operation.

526

Message: NetBackup Delete Image Failed

Cause: NetBackup encountered errors when attempting to expire an
incomplete backup image. This error typically indicates that the previous
operation has failed, and DB2 is attempting to delete any incomplete
images.

528
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Configuration for a DB2 EEE
(DPF) environment

This appendix includes the following topics:

■ Overview of installation and configuration for a DB2 EEE (DPF) environment

■ Configuring NetBackup for DB2 in an EEE environment

■ Adding NetBackup policies for DB2 EEE environment

■ Backing up archive logs in a DB2 EEE environment

■ Creating DB2 templates or scripts for a DB2 EEE environment

Overview of installation and configuration for a DB2
EEE (DPF) environment

The IBM DB2 Enterprise Extended Edition (EEE) environment is a database that
is distributed across multiple hosts or partitions. In a non-EEE environment, the
database is typically centralized on a single host. The Database Partitioning
Feature (DPF) is equivalent to the EEE.

All instructions that refer to an EEE environment are also applicable for a DPF
environment.

In a DB2 EEE (DPF) environment, install the NetBackup client on every client used
by DB2.
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ConfiguringNetBackup forDB2 inanEEEenvironment
The configuration process for NetBackup for DB2 in a DB2 EEE environment is
the same as the configuration process for NetBackup for DB2 in a non-EEE
environment with the exception of the procedure for adding a backup policy.

■ Set the Maximum Jobs Per Client property.
The instructions for setting this property for DB2 EEE are the same as those
for DB2.
See “Configuring the Maximum jobs per client” on page 35.

■ Add NetBackup policies for the DB2 EEE environment.
The instructions for adding policies to NetBackup are different for DB2 EEE.
See “Adding NetBackup policies for DB2 EEE environment” on page 140.

■ Create DB2 scripts for the DB2 EEE environment.
The instructions for creating scripts for DB2 EEE are the same as those for
DB2.
See “About NetBackup for DB2 templates and shell scripts” on page 61.

■ See “Creating DB2 templates or scripts for a DB2 EEE environment” on page 141.

■ Create a $DB2_Instance_Home/db2.conf file.

The instructions for configuring the db2.conf files for DB2 EEE are the same
as those for DB2.
See “Configuring the runtime environment” on page 48.

■ Test NetBackup for DB2 EEE configuration settings.
The instructions for testing DB2 EEE configuration settings are the same as
those for DB2.
See “Configuring the Maximum jobs per client” on page 35.

Adding NetBackup policies for DB2 EEE environment
The following policies must be configured for a DB2 EEE environment:

■ A DB2 type policy with an Application Backup schedule type.

■ Include only one Application Backup schedule type. Delete the schedule
called Default-Application-Backup.
For complete instructions on how to create this type of schedule, see the
following:
See “Configuring NetBackup for DB2 automatic backup schedules”
on page 40.
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■ In the client list, include all clients you want to back up, including the DB2
catalog node.

■ A DB2 policy with an Automatic backup schedule.

■ Include one of the following schedule types: Automatic Full Backup,
Automatic Differential Incremental Backup, or Automatic Cumulative
Incremental Backup. This policy should contain only one automatic backup
schedule type.
For complete instructions on how to create this type of schedule, see the
following:
See “About adding schedules to a NetBackup for DB2 policy” on page 39.

■ Do not specify the automatic backup schedule name in the
$DB2_Instance_Home/db2.conf file. However, for a proxy backup, do
include the automatic backup schedule name.

■ Include only the clients that contain the DB2 catalog node and that run a
DB2 script. The script uses the IBM db2_all command to archive the DB2
catalog nodes before any other node is backed up.

■ Create a Standard type policy with a User Backup type schedule if the following
apply:

■ The userexit program for logging is turned on in DB2 UDB.

■ The client is a UNIX machine.

See “About backing up archive log files with the user exit program” on page 45.

■ If you use the VENDOR method, see the following:
See “Creating a db2.conf file (vendor method)” on page 52.

Backing up archive logs in a DB2 EEE environment
The policy you use to back up the archive logs depends on the method you use for
log archiving. If you use the user exit program, create a Standard policy. If you
use the VENDOR method, you can use the DB2 Application Backup schedule.

Creating DB2 templates or scripts for a DB2 EEE
environment

Templates and scripts operate on a single NetBackup client. If your EEE/DPF
environment spans multiple machines, create at least one template or script for
each machine.
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For example, assume your database spans two hosts, and hostH1 contains partition
P1, and host H2 contains partitions P2 and P3.

You need at least two templates, as follows:

■ One template for partition P1 on host H1

■ One template for partitions P2 and P3 on host H2.

Note:Proper backup and restore of the catalog partition is the user's responsibility.
Generally, it is recommended that the catalog partition is the first node backed
up and the first partition restored. For more information, see your DB2
documentation.

Information is available on how to create backup templates and how to create
recovery templates.

See “Creating a backup template using the NetBackup for DB2 backup wizard”
on page 62.

See “Using the NetBackup for DB2 recovery wizard” on page 82.

Rollforward recovery to a point-in-time (PIT) is not supported. DB2 requires that
PIT recovery be run via the same operation for all partitions and tablespaces on
all machines. Templates do not span machines.

See “Backing up archive logs in a DB2 EEE environment” on page 141.
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Using NetBackup for DB2
with SAP®

This appendix includes the following topics:

■ About NetBackup for DB2 with SAP

■ Installation of the DB2 user exit program

■ Backup and restore of DB2 databases used by SAP

■ Archive and restore of DB2 log files used by SAP

■ Backup of SAP files

About NetBackup for DB2 with SAP
When a DB2 database is used by SAP software, NetBackup for DB2 can be used
within that environment for backup and restore of SAP data. Follow the
recommended installation, backup, and restore guidelines to ensure that SAP,
DB2, and NetBackup work together.

Installation of the DB2 user exit program
DB2 allows for the presence of a single user exit program to manage archiving of
database log files. Both SAP and NetBackup deliver user exit programs for exclusive
use by DB2. The user exit program resides in the DB2 database directory as
db2uext2.

The use of the NetBackup user exit program is required because it automatically
archives log files to a storage unit and because it enables on-demand recovery of
log files by DB2.
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Take precautions when installing SAP to prevent overwriting the NetBackup user
exit program. Always preserve the NetBackup db2uext2 file before installing SAP
and restore afterwards.

Backup and restore of DB2 databases used by SAP
Follow the standard NetBackup instructions in this document for backup and
restore of the DB2 database(s) used by SAP. You can use either DB2 or NetBackup
to initiate database backups and restores.

Note:Do not use SAP CCMS, sapdba, brbackup, or brrestore commands to initiate
backups or restores. They do not invoke NetBackup.

Note: SAP must not be running when you attempt to restore the database.

Archive and restore of DB2 log files used by SAP
Follow the standard NetBackup instructions in this document for configuring the
user exit program. DB2 automatically invokes the user exit program to archive
and recover the necessary log files.

Note: Do not use SAP CCMS, sapdba, brarchive commands, or the SAP Logfile
Management window in the DB2 Control Center for log file archival. They depend
on the SAP user exit program for proper operation.

Backup of SAP files
Be certain to include any and all SAP files when planning for SAP recovery, not
just the DB2 database. For instance, any regular files used by SAP can be backed
up using standard NetBackup file backup procedures.

For file backup instructions, consult the "Performing Backups" section in the
NetBackup Backup, Archive, and Restore online help.
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